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Введение 

 

          В 2013 году прошел первый релиз программного комплекса Adobe Edge Tools, 

состоящий из продуктов: Edge Animate, Edge Reflow, Edge Code, Edge Inspect, Edge 

Web Fonts, Typekit, PhoneGap Build. Основа этого комплекса Edge Animate. Программа, 

призванная удачно дополнить Flash и сохранить позиции Adobe как лидера на рынке 

ПО для веб-дизайна. Компания заявляет, что давно продвигает технологии HTML, в 

качестве примеров можно привести такие продукты как Dreamweaver, Illustrator, Digital 

Publishing Suite и т.д. 

 

 
Стартовое окно Edge Animate* 

 

За три года в программе произошло множество изменений. Добавились многие 

функции для работы с видео, аудио и другими медиафайлами. Изменился и сам 

интерфейс программы. Добавились новые инструменты, которые позволяет веб-

дизайнерам создавать интерактивные HTML-анимации для сети Интернет, цифровых 

изданий, мультимедийной рекламы и множества других ресурсов, которые легко 

запускаются в браузерах для настольных ПК и мобильных устройств.  

 

Новые функции в Edge Animate СС 2015 

 

 Редактирование текстов в монтажной области без использования всплывающих 

окон  

 Поддержка 64-разрядной платформы Chromium Embedded Framework  

 Уменьшение размера среды выполнения на 55%  

 Полная независимость от сторонних библиотек. 

 Пользовательские папки для сохранения изображений, медиафайлов и 

сценариев 

 Уменьшение количества выходных файлов проектов  

___________________________________________________________________________ 
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*Программу можно бесплатно загрузить с сайта Adobe. Ознакомительное время 30 

дней. 

 Новые параметры загрузчика  

 Поддержка видео HTML5  

 Импорт листов спрайта из Flash Professional, Photoshop и других инструментов 

дизайна 

 Поддержка создания связей для статей DPS  

 Обновленный редактор действий  

 Функция копирования и вставки для извлечения графических объектов SVG из 

Illustrator  

 Инструменты «Рука» и «Масштаб» 
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Глава 1. Начало работы 
 

Зачем нужен Adobe Edge 

 

Часто задают вопрос, зачем нужен Adobe Edge, когда уже есть инструменты, 

такие как Flash Professional, для создания интерактивного контента в Веб. Есть ряд 

причин, которые мы сейчас рассмотрим. 

Для начала скажем, что большинство дизайнеров видят мир несколько иначе по 

сравнению с разработчиками (программистами). Если Вы художник, то Вам, наверное, 

будет несколько неудобно описывать каждый круг, цвет и линию в Вашем 

произведении с помощью кода JavaScript, хотя теоретически это возможно. 

Скорее всего, Вам будет гораздо удобнее инструмент, который напоминает 

Adobe Illustrator, Photoshop или Flash. Это именно тот случай, когда на помощь 

приходит Edge Animate. 

У Edge Animate точно такая же шкала времени, что и у Flash и After Effects.  

Панели Свойства (Properties) и Элементы (Elements) напомнят Вам аналогичные 

инструменты редактирования в уже знакомых программах. Когда Вы используете Edge 

Animate для создания графики в HTML 5, Вы можете полностью сконцентрироваться 

на разработке, тонкой настройке и подгонке своей работы. Программа сама 

сгенерирует код HTML 5 и Javascript, который необходим для Ваших веб-страниц. 

 

 
Сравнение Timeline в Flash Professional и Adobe Edge 

HTML технологии 

 

           В HTML 5 появилось достаточное количество новых возможностей, но наиболее 

заметные из них, конечно, те, которые позволяют создавать графику и анимировать ее. 

Если Вы думаете, что все это сильно напоминает Flash, то будете правы. Однако есть 

новая возможность, которую предлагает HTML 5 — это платформонезависимый, 

полностью соответствующий веб-стандартам способ изменения графики, ее цвета, 

размеров, формы и положения во времени. Эта техника использует новые теги HTML, а 

также всю мощь языка программирования JavaScript, а также библиотеку, созданную на 

его базе — jQuery. Эти технологии с открытым кодом доступны любому пользователю 

сети независимо от того создает он веб-сайты или веб-браузеры. 
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Пример кода: 

<video> - for simple video playback in HTML;  

<audio> - for simple audio playback in HTML;  

<canvas> - for programmatically rendering bitmap visuals in HTML through JavaScript APIs.  

 

Мобильные платформы 

 

         Если Вы flash-дизайнер или flash-разработчик, то уже наверняка в курсе дебатов 

между Apple и Adobe относительно судьбы Flash-технологии. Но как для веб-дизайнера 

и разработчика для Вас более важен тот факт, что контент, созданный на базе Flash, не 

просматривается в наиболее популярных мобильных устройствах в мире. Однако, при 

использовании HTML 5 и JavaScript Вы сможете добавить своим сайтам солидный 

кусок аудитории, которая пользуется продукцией Apple и некоторых других 

производителей. 

 

 
 

В обеих версиях как для Windows, так и для Macintosh, Ваша анимация будет 

воспроизводятся практически идентично. 

Кнопки в любых диалоговых окнах выглядят одинаково и выполняют одинаковые 

функции. Ответ программы на любую команду идентичен. 

 

Создание нового проекта Edge 

 

Щелкните левой кнопкой мыши на Create New (Создать новый файл). Перед 

Вами появится рабочее пространство программы с несколькими панелями и 

дополнительными ссылками на уроки от Adobe. (Либо в главном меню выбрать File-

>New.) 

Сохраните ваш проект  File 

→ Save As.  Отметьте галочкой 

Save in a folder. Теперь посмотрите 

на содержание папки. Вы 

обнаружите там 4 файла и папку. 
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Если до этого момента Вы уже занимались разработкой веб-страниц, то наверняка Вам 

покажется знакомой большая часть ее содержания. Но там обнаружится и кое-что 

новое: 

 файл с расширением .an — это файл проекта; 

 файл с расширением .html описывает созданную веб-страницу с помощью 

HTML-разметки; 

 файлы с расширением .js содержат код JavaScript, относящийся к Вашему 

проекту. Сейчас он пустой, но, тем не менее, этот код описывает пустую сцену и 

выполняет другие задачи, необходимые для всех проектов программы. 

 

Откройте папку с именем edge_includes, и Вы обнаружите там файл JavaScript. Это 

библиотеки кода JavaScript. Если Вы используете в Вашем проекте медиафайлы или 

изображения, то они будут распределены по соответствующим папкам. 

Итак, Edge Animate генерирует несколько файлов, которые нужны для того, чтобы 

создать Ваш проект как единое целое и показать Ваш дизайн на странице в браузере. 

Если Вы удалите или переместите один из них, то, скорее всего, дизайн отобразится 

некорректно. Поэтому наиболее важные выводы из этого простого урока должны быть 

следующие: 

 для каждого проекта создавайте отдельную папку; 
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 не удаляйте, не перемещайте и не переименовывайте файлы и папки, 

которые были созданы программой, до тех пор, пока Вы до конца не поймете их 

взаимосвязь. 

 

Глава 2. Рабочее пространство 

 
После того как Вы перешли от стартового экрана к новому проекту или к уже ранее 

созданному, перед Вами появится рабочее пространство Edge Animate с несколькими 

панелями.  

 

Имя каждой из них можно увидеть на ярлыке в верхней части.  

Панели Timeline (Шкала времени),  

Elements (Элементы),  

Properties (Свойства)  

Tools (Инструменты)  

Library (Библиотеки) 

 Самая большая панель по размеру — это Cцена (Stage), на которой эта анимация и 

создается. На ее ярлыке написано название Вашего проекта. 

Сцена — это то место, где Вы будете работать с графикой и текстами для Ваших 

веб-страниц. После сохранения проекта Edge Animate записывает текст и графику в 

виде HTML-страницы. Чтобы проверить это, просто откройте такую страницу в веб-

браузере, и если там есть анимация, то она воспроизведется точно так же как и на сцене 

самой программы. 

Поскольку сцена имеет определенные размеры, то у нее есть физические 

границы. Этим можно пользоваться для того чтобы прятать или размещать элементы за 

пределами сцены. 

Элементы — это объекты, которые Вы добавляете на сцену. В результате они 

появляются на Вашей итоговой веб-странице. Элементами могут быть: 

 графика; 

 фотографии; 

 текст; 

 Аудио; 

 Видео. 
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Свойства (Properties ) 

У всех элементов есть свои свойства, изменяя которые Вы можете влиять на положение 

элемента на сцене и его визуальные характеристики. Управление этими свойствами 

осуществляется в этой панели. 

 

Шкала времени (Timeline)  

отслеживает изменение свойств элементов во времени: 

 местоположения элемента на сцене; 

 визуальные характеристики элемента. 

 

Библиотека (Library)  

В ней хранится графика, импортированная в проект, а также символы, которые Вы 

создали в Edge Animate. 

 

Инструменты (Tools)  

Находятся в верхней части рабочего пространства. Они используются для создания, 

выделения и модификации элементов на сцене. Инструментов немного, но Вы будете 

удивлены их возможностями. 

 

Уроки (Lessons)  

Здесь находятся ссылки на уроки для начинающих, которые могут оказаться весьма 

полезными первое время. Здесь Вы получите пошаговые инструкции и увидите 

результат их применения прямо на сцене программы. После просмотра этих уроков 

можно эту панель закрыть, нажав на кнопке Х ее ярлыка. Тем самым Вы сохраните 

приличный кусок пространства для своей основной работы в Edge Animate. 

Рабочее пространство Edge Animate состоит из нескольких панелей, которые можно 

перемещать и изменять в размере. В центре находится Сцена (Stage). На ней 

размещаются графические элементы для создания анимации. 

Рабочее пространство Adobe Edge Animate во многом схоже с другими 

программами компании Adobe. Если Вы использовали в своей работе последние версии 

Dreamweaver, Photoshop или Flash, то быстро сориентируетесь. Если же это Ваша 

первая программа от Adobe, то все приемы, которые Вы здесь изучите, можно будет 

использовать и в других приложениях. 

Итак, все панели стыкуются друг с другом, словно пазл, но его порядок может 

быть легко изменен. Кроме того, можно менять размер панелей и делать их 

«плавающими», чтобы они стали независимыми от других. Чтобы сделать последнее, 

достаточно щелкнуть на маленькой кнопке меню в правом верхнем углу панели и затем 

выбрать Undock Panel (Отстыковать панель). В результате она станет «плавающей» 

относительно всего рабочего пространства Edge Animate. 
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Сохранение рабочего пространства пользователя 

 

После того как Вы начнете менять положение панелей относительно друг друга, 

может возникнуть две ситуации: либо Вам понравится их новый порядок, либо нет. 

Предположим, Вы нашли идеальный вариант расположения панелей и их количества. 

Например: Вы пользуетесь двумя мониторами и хотели бы, чтобы на одном из них 

были сцена и Шкала времени, а на другом – панели Свойства, Элементы и Библиотека. 

Теперь, чтобы сохранить такой макет рабочего пространства, сделайте 

следующее: в главном меню программы выберите Window → Workspace → New 

Workspace.... 

Перед Вами появится диалоговое окно, в котором Вы можете записать имя этого 

макета, например myLayout. Щелкните на OK, и имя Вашего пользовательского 

рабочего пространства появится в соответствующем меню. Выбирайте его, когда 

посчитаете нужным.  

 

 

С другой стороны, после многократного изменения макета рабочего пространства 

может оказаться, что он Вам не нравится и Вы хотели бы вернуться к исходному 

варианту. Для этого выберите Default или любое другое название в меню Workspace. В 

случае выбора Default на экране появится макет по умолчанию. Чтобы вернуть текущее 

рабочее пространство к его последней сохраненной версии, используйте опцию Reset 

(Сбросить). 

 

Главное меню 
 

Большинство компьютерных программ имеют стандартное системное меню, которое 

включает в себя стандартные пункты, такие как Файл, Правка, Вид, наряду с другими. 

Edge ничем не отличается в этом отношении. 

 

 
 

File 
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•New: Создает новый пустой проект Edge. 

•Open: Открывает ранее сохраненный Edge проект. 

•Open Recent: Содержит список недавно открытых проектов Edge, которые 

пользователь может выбрать.  

•Close: Эта команда закрывает текущий проект Edge, предлагая пользователю 

сохранить документ. 

•Close All: закрытие всех текущих проектов. 

•Save: Сохраняет текущий проект Edge. Только для ранее сохраненных проектов. 

•Save As…: открывает диалоговое окно обзора, предлагая пользователю ввести имя 

проекта и место для сохранения Edge проекта. 

•Publish Settings: Настройки публикации в Веб. 

•Publish: Публикация. 

•Revert (Возврат): Возвращает открытый  Edge проект до его последнего сохраненного 

состояния. 

•Preview In Browser: Предварительный просмотр в браузере. Эта команда запустит 

браузер с текущим проектом Edge. 

•Import: Позволяет импортировать PNG, GIF, JPG, SVG файлы в Edge проект. 

•Import Spritesheet: Импорт листов спрайта из Flash Professional, Photoshop и других 

инструментов дизайна. 

•Exit: закрывает приложение.  

 

Edit 

В меню Правка позволяет прямое манипулирование объектом через команды 

вырезать, копировать и вставить, наряду с выбором вариантов, и доступ к отмена / 

повтор истории. 

• Undo: Отменяет предыдущее действие. 

• Redo: Повторить предыдущее действие. 

• Cut: Удаляет выбранный элемент. 

• Copy: Копирует выделенный элемент. 

• Paste: Вставляет ранее вырезанный или скопированный элемент на сцену. 

• Paste Special: Специальная вставка. На самом деле это серия команд, которая 

позволяет склеивания, специфические атрибуты. Как и любая команда Вставить, 

эти атрибуты и сопровождающие элементы должны были вырезаны или 

скопированы до этого. 

•Paste Transitions To Location: Будет точно воспроизводить движения из 

скопированных элементов. Вставляется вместо текущего положения. 

•Paste Transitions From Location: Будет точно воспроизводить движения из 

скопированных элементов. Вставляется после текущего положения. 

•Paste Inverted: Вставляется с движением в обратную сторону. 

•Paste Actions: Будет вставлено только действие. 

•Paste All: Будет вставлен элемент, который был скопирован или вырезан в 

качестве нового элемента вместе со всеми своими свойствами. 

• Duplicate: Делает копию выбранного элемента. 

• Select All: Выбрать все. 

• Transform: Трансформация объекта. 
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• Delete: Удаляет выбранный элемент со сцены. 

 

View 
 

•Zoom In: Увеличить. 

•Zoom Out: Уменьшить.  

•Actual Size: Фактический размер. 

• Rulers: Линейки. 

• Guides: Направляющая. 

• Snap to Guides: Привязка к направляющей. 

• Lock Guides: Запереть направляющие. 

• Smart Guides: Умная направляющая. 

• Preloader Stage: Сцена предзагрузчика. 

 

Modify 
 

•Arrange: Организация элементов на сцене.  

oBring to Front: Переместить наверх.  

oBring Forward: Переместить наверх на один элемент. 

oSend Backward: Переместить вниз на один элемент. 

oSend to Back: Переместить вниз. 

•Align: Выравнивание элементов в сцене. 

oLeft: Выравнивание по левому краю. 

oHorizontal Center: Выравнивание по центру, по горизонтали. 

oRight: Выравнивание по правому краю. 

oTop: Выравнивание по верхнему краю. 

oVertical Center: Выравнивание по центру, по вертикали. 

oBottom: Выравнивание по нижнему краю. 

•Distribute: Выравнивание элементов  относительно других 

oLeft: Выравнивание по левому краю. 

oHorizontal Center: Выравнивание по центру, по горизонтали. 

oRight: Выравнивание по правому краю. 

oTop: Выравнивание по верхнему краю. 

oVertical Center: Выравнивание по центру, по вертикали. 

oBottom: Выравнивание по нижнему краю. 

•Enable Smart Guides: Включает точную привязку к сетке при перетаскивании. 

•Convert to Symbol…: Превращает элемент сцены в символ.  

•Group Element in DIV: Объединение элементов тэгом  <div>. 

•Ungroup Elements: Разгруппировка элементов. 

•Edit Symbol: Редактирование символа. 

 

 

Timeline 

 

•Play/Pause: Воспроизведение таймлинии.  

•Go to Start: Перемещение указателя воспроизведения в начало таймлинии.  

•Go to End: Перемещение указателя воспроизведения в конец таймлинии.  

•Go to Previous Keyframe: Перемещение указателя воспроизведения в предыдущий 

ключевой кадр. 
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•Go to Next Keyframe: Перемещение указателя воспроизведения в 

следующий ключевой кадр. 

•Auto-Keyframe Mode: Автоматическое создание ключей при перемещении 

объектов.  

•Auto-Transitions Mode: Автоматическое создание кадров при перемещении объекта. 

 

•Add Keyframe: Добавление ключей. 

•Insert Label: Добавляет метку к ключевому кадру. 

•Insert Trigger: Добавляет действие в нужный ключевой кадр. 

•Create Transitions: Добавить кадры между двумя ключами. 

•Remove Transitions: Удалить кадры между двумя ключами. 

•Invert Transitions: Поменять местами кадры между двумя ключами. 

•Insert Time: Вставить временной промежуток перед ключом. 

•Toggle Pin: Шпилька. Метка временной шкалы.  

•Snapping: Привязка  

•Snap To: Позволяет сделать привязку к параметрам.  

oGrid: Привязка к сетке.  

oPlayhead: Привязка к указателю воспроизведения. 

oКеуframes, Labels:  Привязка к ключам, меткам.  

•Zoom In: Увеличение временной шкалы.  

•Zoom Out: Уменьшение временной шкалы. 

•Zoom to Fit: Показать всю временную шкалу. 

•Expand/Collapse Selected: Развернуть\Свернуть параметры объекта, на временной 

шкале. 

•Expand/Collapse All: Развернуть\Свернуть параметры всех объектов, на временной 

шкале. 

 

Window 
 

•Workspace: Управление рабочим пространством. 

oDefault Рабочее пространство по умолчанию.  

oNew Workspace: Запоминает  текущее рабочее пространство. 

oDelete Workspace: Удаляет выделенное рабочее пространство. 

oReset "{workspace}"…: Сброс  к  текущему рабочему пространству. 

•Timeline: Включает  Timeline. 

•Elements: Включает  Elements  

•Library: Включает  Library. 

•Tools: Включает  Tools. 

•Properties: Включает  Properties. 

•Code: Включает  панель Code. 

 

Панель инструментов 

 

 
 

•Selection tool: Служит для выделения и перемещения объектов в сцене. 

•Transform tool: Трансформирует и модифицирует объекты. 

•Clipping tool: Обрезка элементов в сцене. 

•Rectangle tool: Прямоугольник. 

•Rounded Rectangle tool: Скругленный прямоугольник. 

•Ellipse tool: Овал. 
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•Text tool: Работа с текстом. 

•Background Color and Border Color: Цвета рамок и контура. 

 

_________________________________________________________________________ 

*Важно! Не все веб-браузеры корректно воспринимают стандарт HTML5. 

Скажем, в Firefox и Chrome эллипсы будут отображаться корректно, а в Safari будут 

квадраты. В Internet Explorer отображаться ничего не будет, если не установить Google 

Chrome Frame. Это – бесплатный подключаемый модуль, который позволяет 

использовать преимущества HTML5 в браузере Internet Explorer. 

 

Глава 3. Первая анимация 
 

Следуя доброй традиции, давно укоренившейся в мире программистов, давайте 

используем для нашей первой анимации в Edge Animate фразу "Hello World!". 

Программа сгенерирует код, который будет показывать эту страницу и анимацию на 

ней. Этот и последующий уроки должны Вас привести к результату, который показан 

ниже. 
 

 

Для того чтобы это сделать, нам понадобится: 

 картинка земного шара, который будет появляться и исчезать. 

Запустите Adobe Edge Animate. В главном меню программы выберите File → New 

для того, чтобы создать новый документ. Итак, перед Вами пустая сцена. В данный 

момент она является единственным элементом, который отображается в панелях 

Свойства (Properties) и Элементы (Elements). Панель Свойства отображает ее размеры, 

цвет и другие параметры. Чуть позже мы поговорим о них более подробно. 

http://edge-animate.ru/
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Создайте папку для Вашего проекта и в главном меню выберите File → Save As 

(Сохранить как), чтобы сохранить Ваш файл. Имя ему дайте любое. Пусть это будет 

hello_world. 

Вы можете создать папку в программе, отличной от EA, например, используя 

Windows Explorer, или создать ее как часть общей команды File → Save As. 

Выработайте у себя привычку сохранять каждый Ваш новый проект в Edge Animate с 

именем, из которого сразу понятно, с чем этот проект имеет дело. Такие имена 

называют описательными. 

Гораздо проще в самом начале работы сохранить проект, а затем периодически 

сохранять уже сделанное с помощью горячих клавиш Ctrl + S. Как уже объяснялось в 

предыдущих уроках, гораздо практичнее сохранять новый проект в новой папке, т.к. 

программа создает несколько файлов и папку edge_includes во время первого 

сохранения проекта. 

С первого взгляда на Edge Animate можно понять, сохранили ли Вы свой проект 

или нет. Если нет, то программа показывает звездочку * рядом с именем файла в 

верхней части окна. 

В панели Свойства кликните на образце цвета фона. Сейчас он белый. Появится 

небольшая панель, на которой Вы можете выбрать цвет. Если Вы любите выбирать 

цвета визуально — воспользуйтесь спектральной полоской слева. Так можно быстро 

выбрать основной оттенок желаемого цвета. Затем кликните внутри квадрата 

посередине панели, чтобы выбрать более точный оттенок. 
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Иногда, в процессе работы, если Вам заранее известно точное значение цвета, 

Вы будете пользоваться полями для ввода этих значений в форматах RGB или 

числовом шестнадцатиричном. Эти поля находятся в правой части панели. 

Выберите темно-синий цвет, который ассоциируется с космосом. Если 

сомневаетесь, то попробуйте, например такой: R=25; G=30; B=60; A=100. Подсветка 

чисел оранжевым цветом означает, что Вы можете либо кликнуть на любом из них и 

ввести нужное Вам значение, либо кликнуть левой кнопкой мыши и, удерживая ее, 

потянуть влево или вправо, тем самым изменяя значение числа в поле. Вправо — 

увеличиваем, влево — уменьшаем. 

Продолжаем работать со свойствами сцены. Выберите для свойства Overflow 

(перетекание) значение hidden (скрытый). Overflow контролирует видимость элементов 

во время просмотра итоговой веб-страницы в браузере. Сцена может быть лишь частью 

целой веб-страницы. Измените значение этого свойства на hidden, чтобы скрыть 

нежелательные элементы. 

 

 
 

В главном меню выберите File → Import. В появившемся окне найдите и 

выберите файл earth.png (если у Вас отсутствует этот файл, то можно взять другую 

картинку, или просто нарисовать круг, используя инструмент Ellipse Tool). Кликните на 

Open (Открыть), чтобы импортировать файл в Ваш проект. 
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После того как Вы это сделали, импортированный файл появится в панели 

Элементы и отобразится на сцене. При этом он автоматически становится выделенным, 

что позволяет видеть его свойства в панели Свойства. 

Свойство, отвечающее за видимость нашего первого элемента, находится в 

верхней части панели. Ниже расположена панель Position and Size (Местоположение и 

размер). 

Еще ниже — панель Transform (Трансформации), где Вы сможете вращать, наклонять и 

масштабировать элементы. 

Далее, в разделе Image (Картинка), указывается имя файла-источника. Это 

хорошая подсказка в ситуации, когда Вы пытаетесь вспомнить, а какое же имя 

исходника у этой картинки! 

Есть еще один секрет, который происходит за кулисами программы. Когда Вы 

импортируете картинки, то Edge Animate автоматически: 

 создает папку для их хранения; 

 создает копию выбранной картинки; 

 помещает ее в эту папку. 

Кроме того, импортированная картинка появится в разделе Assets (Активы) панели 

Library (Библиотека). 

Теперь в самом верху панели Properties (Свойства) кликните на боксе ID 

(идентификатор) и измените earth на world. 

 

 
Во время импорта графики программа присваивает ей имена файлов. В 

определенных случаях это удобно, но чаще Вы будете менять имена элементов (т.е. их 

ID) непосредственно в программе. Эта процедура не изменяет имени самого файла. 

Новый ID элемента будет использоваться только внутри программы. 

ID элементов выполняют важную функцию внутри кода HTML, о которой Вы 

узнаете далее в этих уроках. Заметьте также, что в панели Elements Ваш world появился 

с новым именем. Ну и поскольку он уже находится на сцене, то и на шкале времени он 

тоже отображен. 

Имена элементов на шкале времени, которые не анимируются, могут 

показываться, либо скрываться. Вы можете это сделать, нажав на небольшую кнопку с 

иконкой в виде воронки Only show animated elements (Показывать только 

анимированные элементы) внизу шкалы времени. 

Убедитесь, что головка плеера на шкале времени находится в значении 0:00. 

Если Вы не вносили изменений на шкале времени с момента создания проекта, то эта 

головка и будет находиться в самом ее начале, т.е. в первом кадре Вашей анимации. 

Если Вам нужно переместить головку, то потяните за ее нижнюю часть золотистого 

цвета. Верхняя часть головки называется шпилька (pin). При перемещении головки она 

следует за ней автоматически. Мы познакомимся с головкой более подробнее позднее в 

этом уроке. 

Перетащите world за пределы сцены вниз. Ранее мы обсуждали тот момент, что 

элементы, находящиеся вне сцены могут быть скрыты во время показа страницы в 
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браузере. Если значение Overflow установлено как hidden, то такие элементы 

будут выглядеть немного темнее, чем обычно. 

Убедитесь, что кнопка Auto-Keyframe Mode (Режим автоматического создания 

ключевых кадров) нажата. Это значит, что при изменении свойств элементов на шкале 

времени ключевые кадры будут создаваться автоматически. Маркеры ключевых кадров 

выглядят в виде небольших ромбов (о них чуть позже). 

На панели Шкала времени, кнопки, которые активны, т.е. нажаты или включены, 

выглядят темнее, а их иконки чуть ярче. Например, когда кнопка Auto-Keyframe Mode 

(с картинкой секундомера) нажата, то у секундомера циферблат ярко-красный. 

Убедитесь, что кнопка Auto-Transition Mode (Режим автоматического создания 

переходов) нажата. Если этот режим включен, то Edge Animate автоматически создает 

плавные переходы между состояниями элемента во времени. В нашем примере, 

элемент world будет плавно перемещаться из одного положения на сцене в другое. 

Перетащите головку плейера в значение 0:01 на шкале времени. 0:01 — это секунда 

времени анимации. Красная линия, которая тянется вниз от головки, является 

своеобразным маркером для всех элементов и слоев. 

Выделите элемент world, кликнув на нем, а затем в панели Properties в разделе 

Position and Size (положение и размер) кликните на ромбиках рядом с Х и Y. 

На шкале времени появятся два ключевых кадра в виде ромбов, которые фиксируют 

положения левой и верхней границ элемента world. Свойства Х и У устанавливают 

положение элементов на сцене. Кликнув на ромбах рядом с Х и У в разделе Position and 

Size панели Properties, Вы вручную определили положение элемента world на сцене. В 

результате он будет оставаться в этом положении в течение первой секунды анимации. 

 

 

 
 

Adobe Edge Animate автоматически присваивает цвет каждому элементу Вашего 

проекта. Этот цвет можно увидеть на шкале времени рядом с именем элемента, а также 

он используется для отображения переходов — изменений значений свойств. Тот же 

самый цвет находится рядом с именами в панели Elements (Элементы). Когда Вам 

приходится иметь дело с десятками или даже сотнями элементов, такое цветовое 

кодирование здорово помогает. 

Кликните на кнопке-переключателе шпильки (Toggle Pin) на шкале времени, 

затем перетащите золотистую часть головки плеера к значению времени 0:03. Для того 

чтобы анимировать элемент, нужно чтобы его свойства изменялись в течение 
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определенного промежутка времени. Головка и шпилька обеспечивают Вам 

возможность отметить две точки на шкале времени, как показано на рисунке. 

 

 
 

Перетащите элемент world на сцену так, чтобы он был хорошо виден. 

Разместите его примерно по центру сцены или в другое положение, которое Вам 

больше нравится. 

 

 
 

Кликните на кнопке-переключателе шпильки (Toggle Pin). Нажмите клавишу 

Home, а затем клавишу пробел (spacebar). После нажатия Home головка вернется к 0:00. 

Нажав на пробел, Вы запустите воспроизведение анимации и сможете просмотреть ее в 

действии на сцене. 

Переместите головку назад на 0:00 и затем в панели инструментов (в верхнем 

левом углу окна программы) кликните на букве Т. Этим действием Вы выбрали 

инструмент работы с текстом, при этом курсор должен измениться на крестик. 

Кликните в любом месте сцены. Появится панель для ввода текста. Введите текст Hello 

World!. После того как Вы это сделали, нажмите клавишу ESC или кликните мышью на 

кнопке Х в верхнем правом углу панели для ввода текста. Фраза Hello World! появится 

на сцене, но ее положение и характеристики шрифта необходимо изменить для того, 

чтобы текст был нужных размеров и цвета. 

В панели Properties измените ID только что созданного текстового элемента на 

HelloWorld. Это позволит Вам гораздо быстрее отличать и находить этот элемент на 

шкале времени и в панели Elements. В именах элементов не должно быть пробелов, 

поэтому используйте либо HelloWorld, либо Hello_World. 
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Отформатируйте текст, используя панель Properties. Измените его цвет на белый 

или светло-голубой. Используйте шрифт Arial Black или другой жирный шрифт. 

Измените размер шрифта таким образом, чтобы текст заполнил сцену почти полностью 

по ширине (примерно 72 px). При этом программа фиксирует каждое изменение текста 

на шкале времени, добавляя слои свойств и создавая ключевые кадры. 

Переместите текст на сцене в нужное положение, примерно в верхнюю треть 

сцены, отцентровав его по горизонтали. 

Установите значение прозрачности (opacity) для текста на 0 (головка при этом 

находится на 0:00). Слайдер регулировки прозрачности находится наверху панели 

Properties. Таким образом, текст будет невидимым в начале анимации. На сцене видна 

только область выделения текста (голубой контур с узелками), но если Вы щелкните в 

любом пустом месте сцены, то она исчезнет. Однако, не беспокойтесь — Вы сможете 

выделить любой элемент, видимый или невидимый, кликнув на его имени в панели 

Elements. 

Убедитесь, что кнопка Toggle Pin выключена. В этом случае кнопка не выглядит 

нажатой и шпилька движется вместе с головкой. 

Переместите головку на 0:00. Выделите текст и кликните на ромбике (Add 

Keyframe for Opacity) рядом с прозрачностью в панели Properties. Когда Вы 

перетаскиваете головку плеера, то Вы видите, что земной шар перемещается на сцене. 

Кликнув на ромбике прозрачности, Вы создали ключевой кадр на второй секунде, при 

этом текст все еще невидим. 
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Кликните на кнопке Toggle Pin и переместите головку на 0:03. Теперь можно 

сделать еще один переход. 

Выделите текст Hello World!, установите его прозрачность на 100. Программа 

создаст плавный переход, при котором текст будет постепенно изменять свою 

прозрачность от 0 (невидимый) до 100 (полностью видимый) в промежутке времени от 

0:02 до 0:03 Вашей анимации. 

 

 
Переместите шпильку (pin) на 0:03, затем переместите головку на 0:04 и 

установите прозрачность текста снова на 0. Он исчезнет. 

Нажмите Ctrl + S, чтобы сохранить проект. Как уже объяснялось ранее, Adobe 

Adge Animate сохраняет Вашу анимацию в виде нескольких файлов HTML и JavaScript. 

Главный HTML-файл носит имя, которое Вы дали своему проекту, когда впервые его 

сохраняли. Например, в Вашей папке проекта Вы можете видеть файл hello_world.html. 

Во время импорта картинки в проект, Edge Animate создал специальную папку images и 

поместил в нее копию этой картинки. 

Итак, работа над Вашей первой анимацией завершена. Вы можете просмотреть 

ее, нажав на клавишу Home и затем на клавишу Пробел. Земля появится на сцене, 

поднимаясь снизу вверх, а текст сначала появится и затем исчезнет. Вся анимация 

длится всего 4 секунды. 

Нам осталось только просмотреть нашу анимацию в браузере и подвести 

некоторые промежуточные итоги. 
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Глава 4. Просмотр в браузере 

 
Посетители Вашего сайта или веб-страницы не смогут просмотреть созданную 

анимацию непосредственно в программе Adobe Edge Animate, а увидят ее в своем 

любимом веб-браузере. Это значит, что и Вы должны предварительно посмотреть ее 

там же (и желательно не в одном). 

Для быстрого просмотра выберите File → Preview In Browser (Файл – 

Просмотреть в браузере). Программа запустит Ваш браузер, если он еще не работает, и 

откроет HTML-файл, который был создан при сохранения проекта. 

 

 
 

 

Этот единственный HTML-файл является описанием веб-страницы, которую и 

увидят посетители. Все, что им будет нужно сделать — это загрузить ее в браузере. 
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Пример кода HTML страницы 

 

По сути, HTML-код этой страницы является своеобразным концентратором для 

других файлов, в которых нуждается анимация. Он ссылается на картинку earth.png, 

сохраненную в виде отдельного файла в папке images. Кроме того, с него идут ссылки 

на несколько файлов JavaScript, которые, собственно, и приводят все в движение. 

Одна из ключевых вещей в анимации — это тайминг или хронометраж, который 

определяет темп и ритм движений. Возможно, Вам что-то не понравится в своей первой 

анимации, скорость движения планеты, например, или другие аспекты. В последующих 

примерах мы подробнейшим образом разберем, как их настраивать для того, чтобы все 

выглядело хорошо. 

Ну а теперь давайте подведем краткие итоги того, что мы уже узнали из 

предыдущих уроков и о чем мы должны обязательно помнить в будущем при создании 

анимаций: 

 

 Edge Animate создает несколько файлов и папок, поэтому сохранять каждый 

новый проект лучше всего в отдельной папке. 

 Вы можете создавать и сохранять свое пользовательское рабочее пространство в 

программе, которое лучше всего соответствует Вашим привычкам в работе. 

 Когда Вы импортируете графический файл в проект — Edge Animate создает его 

копию и сохраняет ее в папке images. 

 Для того чтобы поля с настройками свойств элемента отобразилась на экране, 

нужно выделить сам элемент на сцене или в панели Elements и они появятся в 

панели Properties. 
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 Чтобы изменить местоположение или визуальные характеристики 

элемента – выделите его и затем измените его соответствующие свойства. 

Например, для того чтобы переместить элемент на сцене — измените его 

свойства Х и У в разделе Position and Size панели Properties. Для того чтобы 

изменить его цвет или прозрачность — отрегулируйте свойства Color (цвет) и 

Opacity (прозрачность). 

 На шкале времени ключевые кадры фиксируют состояние свойств элемента в 

данный момент времени. 

 Анимация возникает тогда, когда свойства элемента(ов) изменяются во времени 

и эти изменения отмечены ключевыми кадрами на шкале времени. 

 Анимационные переходы (в дальнейшем будем называть их просто переходы, 

для простоты) могут быть гладкими или резкими. 

 Горячие клавиши, которые нужно запомнить: Home – перемещает головку 

плейера в значение 0:00 на шкале времени; клавиша Пробел запускает 

анимацию; Ctrl+Enter — запускает анимацию в Вашем веб-браузере. 

 

 

  

 Важно!  Несколько слов о формате HTML 5 

Прежде всего нужно сказать, что переход веб-

индустрии к полному соответствию HTML 5 не 

произойдет за одну ночь. Свойства, которые делают 

этот формат действительно ценным, реализуются 

постепенно в различных браузерах. Если Вы хотите 

протестировать свой браузер на предмет 

соответствия этим стандартам, то воспользуйтесь 

услугами сервиса The HTML 5 Test (http://html5test.com/). 

На нем, Вы увидите какие свойства HTML 5 

поддерживает Ваш браузер. Чтобы посмотреть как 

обстоят дела у его конкурентов кликните на ссылке 

other browsers (другие браузеры). 

В интернете есть еще несколько достойных ресурсов, 

которые предоставляют информацию о возможностях 

браузеров. Например, Can I Use (http://caniuse.com/) 

перечисляет элементы HTML 5, CSS и JavaScript. 

Нажмите на любом из них и перед Вами появится 

таблица, отображающая браузеры и их версии, 

которые поддерживают этот элемент. 
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Окно настройка публикации 

 

 

 

 
 

•Web – Публикация на веб странице. 

oTarget Directory: – Директория публикации. 

oUse Google Chrome Frame for IE 6, 7, and 8 – Использовать Google Chrome 

Frame для отображения в Internet Explorer. 

oChrome Frame Installer: – Опции инсталлятора. 

oPublish content as static HTML – Публиковать без анимации. 

•Animate Deployment Package – Для экспорта в другие пакеты (например InDesign). 

•iBooks/OS X – Экспорт для электронных книг (понимающих формат .wdgt). 

 

После сохранения настроек выберите в меню пункт Publish. 

В папке, в которой Вы сохранили проект, появится директория publish со всеми 

файлами публикации. В зависимости от настроек, которые Вы указали. 

 

Глава 5. Веб-шрифты, и как с ними работать 

 
Существует ряд ограничений на использование тех или иных шрифтов в веб-

дизайне. Главным образом это определяется тем, что на каждом компьютере могут 

оказаться различные шрифты, и не угадаешь, будет ли у пользователя установлены те 

шрифты, которые используются в дизайне сайта. Поэтому в веб-дизайне принято 

пользоваться универсальными шрифтами, одинаково отображаемых на большинстве 

компьютерах. 

Все изменилось с появлением в CSS правила @font-face, которое позволяет 

определить настройки используемых шрифтов, а главное – подгружать отсутствующие 

у пользователя шрифты. 

В данном примере мы будем работать с сервисом Google Web Fonts 

(http://www.google.com/webfonts). Он представляет собой коллекцию бесплатных 

шрифтов, в том числе и с кириллицей. Эти шрифты можно скачать и/или подключить к 

сайту. 
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Для начала нужно определиться со шрифтом или шрифтами, которые Вы будете 

использовать. Так как Ваш сайт, скорее всего – русскоязычный, то следует указать в 

настройках группы шрифтов Cyrillic или Cyrillic Extended, так как не все шрифты 

поддерживают кириллицу, а также включить показ всех стилей. 

 

 

В выбранном шрифте нажмите на «Quick-use». 

Чтобы шрифт правильно отображался, укажите язык, для которого он будет 

использоваться, для русского языка нужно указать Cyrillic. 
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Необходимо скопировать полученную ссылку. 

 

В Adobe Edge выделите нужный текст. На панели свойств, нажмите выбор 

шрифта и выберите Add Font… 

 
 

Появится диалоговое окно. 
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В поле: Font Fallback List: Вставляем название шрифта. 

В поле: Embed Code: Вставляем ссылку скопированную ранее. 

 

 
 

Текст, набранный выбранным шрифтом, отобразится на экране. 

 

 
 

Глава 6. Параметры сцены 
 

Имя программы, Edge Animate, говорит само за себя — этот инструмент 

предназначен для создания и управления анимацией. Используя программу, Вы 

сможете определять, какие элементы будут показаны на сцене, их местоположение и 

визуальные характеристики. 

Вы сможете создавать текст и простые геометрические формы непосредственно 

в Adobe Edge Animate, но, скорее всего, большую часть графических объектов Вы 

будете создавать в других программах, таких как, например Illustrator или Photoshop, а 

затем импортировать их в Edge Animate. 

Этот урок и несколько последующих расскажут Вам о типах графики, которые 

Вы сможете (и не сможете) создавать внутри Edge Animate. Мы начнем с разбора 

параметров сцены и способов их изменения. Вы узнаете обо всех свойствах обычного 

прямоугольника и прямоугольника со скругленными углами. Вы увидите, что в 

программе можно создавать и довольно сложные фигуры. 

Кроме того, Вы узнаете, как быстро выравнивать и ранжировать объекты на 

сцене, и впервые испытаете в действии инструменты трансформации и обрезки. 

Поскольку Edge Animate ни в коей мере Вас не ограничивает в действиях, то Вы 

узнаете, как импортировать графику, созданную в других программах, получив по ходу 

несколько полезных советов на тему, где взять в интернете бесплатные графические 

программы. 

Итак, начнем. Из предыдущих уроков Вы уже успели узнать, что если Вы помещаете 

элемент на сцену, то он становится видимым при просмотре файла в браузере. Однако 

существует пара способов спрятать или удалить элементы со сцены. Если у сцены 
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свойство Overflow установлено как hidden, то, помещая элементы за физические 

границы сцены, Вы делаете их невидимыми при просмотре в браузере. В нашей первой 

анимации Вы также использовали свойство Opacity для скрытия текста Hello World! 

Сцена, с которой Вы работаете в Edge Animate, представляет собой лишь часть 

веб-страницы, на которой она воспроизводится. У сцены есть несколько свойств, среди 

которых наиболее очевидные ее размеры и цвет фона. Но Вы наверняка захотите 

познакомиться со всеми, поэтому давайте разберем их все по порядку, начиная с самого 

верху панели Properties: 

ID – это имя Вашей анимации. Во время сохранения проекта Edge Animate 

создает веб-страницу. Большинство браузеров показывают ID веб-страницы в самом 

верху окна там, где обычно показывается заголовок. 

Изначально размеры сцены представлены как W (ширина) и H (высота) в 

пикселах. Изменить их можно, вводя новые значения непосредственно в эти поля или 

наведя курсор на любое из них, нажав при этом левую кнопку мыши, и перемещать ее 

влево или вправо. Сцена не обязательно должна появляться в левом верхнем углу веб-

страницы. В последующих уроках Вы узнаете, как ее позиционировать в нужном для 

Вас месте. 

Для того чтобы заставить размеры сцены изменяться пропорционально, нужно 

кликнуть на пиктограмме звена цепочки рядом с W и H. Чтобы изменять размеры 

независимо друг от друга — «разорвите цепочку». 

 

 
 

В Edge Animate можно изменять единицы измерения с px (пикселы) на % 

(проценты). Например, если Вы установите ширину равной 80%, то она займет 80 

процентов ширины окна веб-браузера, в котором просматривается веб-страница. Это 

очень полезное свойство при разработке приложений для настольных компьютеров, 

ноутбуков и мобильных телефонов. При этом, если окно браузера будет изменяться 

пользователем по ширине, то сцена будет автоматически адаптироваться к новому 

размеру! 

Выбор цвета фона делается с помощью инструмента Пипетка (Color Picker). В 

панели Properties кликните на образце цвета, чтобы появилась пипетка. Кликните на 

спектральной полоске с различными цветами слева, чтобы сделать приблизительный 

выбор цвета. Затем кликните в прямоугольнике по центру панели, чтобы выбрать более 

точный оттенок. В месте клика появится небольшой кружок, а образец выбранного 
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цвета отобразится в правом нижнем углу панели. В правом верхнем углу 

представлены образцы трех наиболее часто используемых цветов: 

 

 белый; 

 черный; 

 прозрачный. 

 

Если Вам нужен один из них, то просто щелкните мышью на образце и его цвет 

будет присвоен объекту. Если числовые значения цвета в форматах RGB или 

шестнадцатиричном Вам заранее известны, то их можно ввести в соответствующие 

поля панели справа. Об этом мы поговорим подробнее чуть позже. 

 

 
 

Для того чтобы определить минимальные значения ширины и высоты сцены, 

используйте поля Min W (минимальная ширина) и Min H (минимальная высота). Веб-

страницы по своей природе не фиксированы. Ваша страница может быть просмотрена 

как на мобильном телефоне, так и на экране цифрового телевизора. Кроме того, Ваши 

посетители могут изменять размер окна браузера. В этом случае Вы можете взять это 

под частичный контроль, установив значения минимальной ширины и высоты сцены. 

Свойство Overflow контролирует видимость элементов, которые находятся за 

пределами сцены. Чаще всего Вы будете устанавливать его как hidden, что делает 

элементы невидимыми, если они находятся вне сцены. Это особенно полезно в случае, 

если Вы хотите, чтобы элемент входил на сцену или уходил с нее во время анимации. 

Если Вы выберите visible, то элементы будут видимы вне зависимости от того, 

покинули они пределы сцены или нет. Опция scroll обеспечивает появление полос 

прокрутки справа и внизу сцены, если элементы покинули ее видимую часть. Опция 

auto автоматически добавляет полосы прокрутки, если за пределами сцены есть какие-

то элементы. 
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Для того чтобы анимация автоматически запускалась при открытии веб-

страницы, нужно поставить галочку в чек-боксе Autoplay (Проигрывать 

автоматически). Если галочка не стоит, то для запуска анимации используется 

JavaScript. 

Composition ID (ID композиции) нужен для идентификации конкретной сцены и 

сопутствующей ей шкалы времени. Это становится особенно актуальным при 

помещении двух и более анимаций на одной веб-странице. Об этом Вы узнаете 

подробнее в уроках про JavaScript. 

Свойства Down-Level Stage (Сцена нижнего уровня) и Poster (Плакат) создают 

альтернативные элементы для веб-браузеров, которые не поддерживают HTML 5. 

Preloader (Загрузчик) отвечает за загрузку всех ресурсов, которые необходимы для 

нормального воспроизведения Вашей композиции на веб-странице. Эти ресурсы 

включают в себя библиотеки JavaScript и графику. 

 

Глава 7. Работа с графическими примитивами 

 
У текущей версии Edge Animate слегка ограниченный набор инструментов 

рисования — нет инструмента Pen (Ручка) и Gradient (Градиент). В связи с этим 

возникает законный вопрос: почему EA выглядит немного примитивнее других 

продуктов компании Adobe, таких как, например Flash или Illustrator? 

Частично из-за того, что эта программа новая. Понятно, что Adobe сначала 

реализовала те инструменты, которые легко освоить и использовать, а затем, через 

некоторое время дополнит их более изощренными. 

Кроме того, нужно помнить еще об одной вещи. Каждый раз, когда Вы рисуете 

графический объект в Edge Animate, программа за кулисами создает код JavaScript, 

который его описывает. Поэтому на данный момент ситуация такова: если Вы хотите 

создавать более сложную векторную графику, Вам нужно использовать для этого 

специализированные программы типа Illustrator. 

Если Вы предпочитаете бесплатные инструменты, то можете воспользоваться 

программами Inkscape и GIMP. Первая создает векторную графику (сходна с Illustrator), 

вторая растровую (похожа на Photoshop).  

 

Создание прямоугольника 

 

Для создания и добавления на сцену цветных прямоугольников используйте 

инструмент Rectangle Tool (Прямоугольник). Такие цветные блоки очень удобны для 
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выделения определенных частей сцены. Например, Вам нужно сделать панель в 

левой части веб-страницы. Добавьте туда цветной прямоугольник и поверх него 

разместите текст или графику, тем самым выделяя его среди остальных элементов. 

Скорее всего, Вы уже знакомы с основными приемами создания прямоугольников: 

 выберите инструмент Rectangle Tool в панели инструментов программы; 

 кликните левой кнопкой мыши на сцене и удерживайте ее; 

 потяните в любом направлении, чтобы определить размер прямоугольника; 

 отпустите левую кнопку мыши. 

 

 

Чтобы создать квадрат — удерживайте клавишу Shift нажатой, пока Вы тянете. 

Новый элемент появится на сцене и автоматически становится выделенным 

(активным). По его периметру расположены восемь маленьких белых квадратиков, 

которые используются для изменения размеров (ширины и высоты). Просто кликните 

мышью на любом из них и, удерживая левую кнопку, потяните в нужном направлении, 

затем отпустите. Размеры прямоугольника изменятся. 

Создание скругленного прямоугольника 

Для создания и добавления на сцену скругленных прямоугольников используйте 

инструмент Rounded Rectangle Tool (Скругленный Прямоугольник). 

 выберите инструмент Rounded Rectangle Tool в панели инструментов 

программы; 

 кликните левой кнопкой мыши на сцене и удерживайте ее; 

 потяните в любом направлении, чтобы определить размер прямоугольника; 

 отпустите левую кнопку мыши. 

Для изменения скругленности углов используйте инструмент Transform Tool. 

Выделите объект. Удерживая кнопку Shift, потяните внутренний маркер до нужного 

положения. 

Используя кнопку Control, можно манипулировать внутренними маркерами по 

отдельности. 

 

Создание эллипса 

 

 выберите инструмент Ellipse Tool в панели инструментов программы; 

 кликните левой кнопкой мыши на сцене и удерживайте ее; 

 потяните в любом направлении, чтобы определить размер прямоугольника; 

 отпустите левую кнопку мыши. 

Чтобы создать круг— удерживайте клавишу Shift нажатой, пока Вы тянете. 
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Основные свойства примитивов 

 

В панели Properties (Свойства) есть общие для всех примитивов настройки. 

ID (Идентификатор). После создания примитива он появится в панели Elements. 

При выделении примитива все его свойства отобразятся в панели Properties. 

Желательно сразу дать Вашему объекту осмысленное имя, как, например header или 

sidebar. Для того чтобы в последствии изменять это имя (если нужно), выделите его и 

сделайте это в поле ID в верхней части панели Properties. Смену имени можно сделать и 

в панели Elements, дважды щелкнув на имени элемента. 

Tag (Тег). В панели Elements Вы увидите, что сразу после имени элемента 

находится тег <div>. При создании примитива ему автоматически присваивается этот 

тег для того, чтобы Edge Animate мог его идентифицировать, изменять местоположение 

и трансформировать. Работая с другими примитивами, Вы сможете выбирать другие 

теги. Например, после добавления фотографии в Вашу анимацию можно изменить 

<div> на <img>, что вполне логично. 

Position (Местоположение). Сразу ниже поля с именем в панели Properties Вы 

обнаружите подраздел Position and Size (Местоположение и размер). Левый верхний 

угол сцены на осях координат принимает значения X = 0 и Y = 0. Перемещение слева 

направо увеличивает значения Х. Перемещение сверху вниз — Y. 

Изначально положение Вашего вновь созданного примитива расcчитывается 

программой от точки, расположенной в его левом верхнем углу. Положение этой точки 

отсчета можно изменить, используя инструмент Relative to (Относительно ...). Он 

выглядит как прямоугольник с маленькими квадратами по углам. Предположим, что 

Вам нужно разместить элемент на определенном расстоянии от нижнего правого угла 

сцены. Для этого используйте нижний правый угол Вашего элемента в качестве точки 

отсчета. Просто кликните на левом нижнем квадратике инструмента Relative to. 

Size (Размер). Рядом со свойствами местоположения X и Y находятся свойства 

размеров: W (ширина) и H (высота). Они изменяются автоматически, если тянуть за 

маленькие квадратики по периметру выделенного объекта. Кроме того, можно вводить 

точные значения размеров, щелкнув в соответствующем поле или перемещая мышь 

влево и вправо при нажатой левой кнопке. 
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Изначально для примитивов в качестве единиц измерения назначены px 

(пикселы). Однако в любой момент Вы можете изменить их на % (проценты). 

Примитив с шириной в 20% будет занимать на сцене 20% ее ширины. Щелкнув на 

иконке звено цепочки, Вы можете включать и выключать пропорциональное изменение 

размеров. 

В последующих примерах Вы научитесь тому, как создавать элементы, 

адаптивные к любому размеру окна браузера, используя % при указании размеров, 

минимальную и максимальную ширину, точку отсчета, а также другие инструменты. 

Display (Отображать). В зависимости от задач анимации, некоторые элементы 

могут постоянно находиться на сцене, тогда как другие появляться и исчезать. Меню 

Display дает Вам возможность управлять этим процессом. В Вашем распоряжении есть 

три опции: 

 Always On (Всегда включен) 

 On (Включен) 

 Off (Выключен) 

Overflow (Переполнение). Это свойство работает аналогично такому же, как и у 

сцены, которое мы разбирали в уроке Параметры сцены в Edge Animate, за 

исключением того, что оно применяется к конкретному примитиву. 

Opacity (Прозрачность). Для того чтобы контролировать прозрачность примитива, 

используйте слайдер в верхней части панели Properties. Если Вы хотите, чтобы 

свойства заливки и контура примитива изменялись независимо друг от друга, то 

щелкните на образцах их цветов (находятся ниже в подразделе Color (Цвет)) и измените 

свойство прозрачности А (альфа-канал). 

Color (Цвет). Конструктивно примитив состоит из двух частей: контура и заливки. 

Можно изменять их цвета независимо друг от друга или делать их прозрачными, 

изменяя значение альфа-канала. Размер контура измеряется в пикселах. Кроме того, 

контур может быть сплошным (solid), пунктирным (dashed), точечным (dotted) или 

отсутствовать совсем (none). В панели инструментов программы (в самом верху окна) 

предлагается еще один способ быстрого изменения цвета контура и заливки 

выделенного элемента. Он работает аналогично тому, который находится в панели 

Properties. 

 

Панель Croners. 

 

По сути дела, в Edge Animate нужен только один примитив – квадрат. Этому 

обьекту можно скруглить углы и превратить его в круг с помощью панели Croners. 

Создайте прямоугольник и оставьте его выделенным. Выберите инструмент 

Transform (Трансформация — Q) в панели инструментов программы, затем наведите 

мышь на маленький ромбик в подразделе Corners (Углы). В результате Вы увидите 

подсказку с надписью Add Keyframe for Border Radius (Добавить ключевой кадр для 

радиусов контура). 

Вверху подраздела есть 3 кнопки, пронумерованные как 1, 4, 8. Ниже этих кнопок 

находится квадрат, разделенный на 4 части тоже в виде кнопок. Каждая кнопка 

соответствует одному из углов прямоугольника. Рядом с каждым углом находится 

цифра, изначально установленная на 0. 

Когда радиус угла равен 0, то углы у фигуры прямые. Кликните на цифре и 

потащите мышь право, чтобы скруглить угол. Число может быть только 

положительным, поэтому перетаскивание влево будет безрезультатным.  
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Верните настройки фигуры к исходным, чтобы она вновь превратилась в 

прямоугольник. Теперь кликните на кнопке верхнего правого угла в подразделе 

Corners. Измените числовое значение радиуса. В результате Вы увидите, что у фигуры 

правый верхний угол останется прямым, в то время как другие скруглятся. Когда 

кнопка угла нажата — это изолирует угол при изменении настроек скругления. 

Еще раз верните настройки фигуры к исходным. Кликните правую верхнюю 

кнопку, чтобы снять изоляцию угла. Кликните кнопку с цифрой 4. Рядом с каждым 

углом появятся цифры. Теперь Вы можете настраивать скругление углов 

индивидуально, придавая им различную степень скругления. Это дает Вам 

возможность создавать фигуры различных форм, хотя технически они будут оставаться 

четырехугольниками! 

Добавьте к этим трансформациям искажения и масштабирование, и у Вас могут 

получиться действительно интересные эффекты. 

Кликните на кнопке 8. Рядом с каждым углом появятся два контрольных числа. 

Это даст Вам возможность перемещать контрольные точки от центра, делая угол более 

плоским с одной стороны по сравнению с другой. Заметьте, что во время изменения 

чисел черные ромбики контрольных точек тоже перемещаются. Следовательно, чтобы 

настроить характеристики угла, нужно менять его числовое значение или тянуть за 

черный ромбик. 

Поэкспериментируйте со свойствами в подразделе Corners, превращая 

прямоугольники в овалы и круги. Вот пример преобразования квадрата в круг: 

Кликните на инструменте Rectangle (Прямоугольник) и удерживая клавишу Shift 

нажатой создайте квадрат. Клавиша Shift помогает создавать фигуры с равными 

сторонами. 

В подразделе Corners кликните на кнопке 1. В результате радиусы всех углов будут 

одинаковыми. 

Кликните на поле с числом и потяните вправо до тех пор, пока квадрат 

превратится в круг. 

Вы можете изменять и настраивать свойства Вашего круга точно так же, как и любого 

другого объекта в Edge Animate. Превратите его в эллипс или овал, искажая и 

масштабируя его. И, конечно же, Вы можете создавать фигуры, промежуточные между 

квадратом и кругом — квадрат со скругленными углами, например. 
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Глава 8. Работа с растровыми объектами 

 
Падающие тени 

 

Падающие тени, которые Вы можете создавать в Adobe Edge Animate, не только 

выглядят круто, но и с практической точки зрения очень полезны — они помогают 

визуально отделять различные графические элементы композиции друг от друга. После 

того как Вы добавите падающую тень к объекту, он начинает словно «плавать» над 

сценой. 

 

 
 

Если Вы используете падающую тень внутри графики, то изображение выглядит 

объемным (трехмерным). Тени очень часто добавляются к кнопкам, чтобы показать их 

различные состояния: 

 курсор над кнопкой (hover); 

 кнопка нажата; 

 кнопка выделена. 

Edge Animate дает возможность легко создавать и настраивать падающие тени для 

графических элементов согласно Вашей потребности. 

Ну что ж, давайте на практике нарисуем тень, которая отделит элемент от фона. 

 Создайте три элемента на сцене. 

 Выделите один из элементов и затем в панели Properties опуститесь вниз к 

подразделу Shadow (Тень). 

 Кликните на кнопке Drop Shadow (Падающая тень) в верхней части подраздела. 

 Кликните на образце цвета тени и выберите черный. 

 Кликните на поле для ввода значения горизонтального сдвига (X) и наберите 3. 

 Кликните на поле для ввода значения вертикального сдвига (Y) и наберите 3. 

 Кликните на поле для ввода радиуса размытия (Blur) и наберите 10. 

 Кликните на поле для ввода распространения (Spread) и наберите 1. 
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Если Вы хотите, чтобы один из элементов выглядел объемным (трехмерным), то 

используйте те же самые установки, но вместо Drop Shadow кликните на кнопке Inset 

(Внутренняя тень). В результате вместо того, чтобы появляться снаружи элемента, тень 

появится внутри него. 

Свойство Spread контролирует распространение тени во всех направлениях. 

Как и любое другое свойство элемента в Edge Animate тени могут быть анимированы. 

Например, чтобы создать иллюзию движения солнца можно анимировать положение и 

размер тени в течение определенного промежутка времени. 

Кроме того, тени являются очень важным аспектом при работе с текстом. Текст 

лучше читается на насыщенном графикой фоне в том случае, если он отделен от нее 

тенью. 

Чтобы включить-отключить тень, кликните на маленькой кнопке в правом 

верхнем углу подраздела Shadow. 

 

Инструмент Clip (Обрезка) 

 

Не всегда графика, добавленная на сцену в Adobe Edge Animate, будет Вас 

устраивать на все 100%. Иногда (особенно при использовании графики заимствованной 

из других источников), ее содержательная часть избыточна, поэтому хочется от всего 

ненужного как-то избавиться. 

Для этих целей Edge Animate предлагает инструмент Clip (Обрезка), который 

может обрезать любую графику. Находится он в панели инструментов программы, 

справа от инструмента Transform (Трансформации). 

Clip — очень простой инструмент. Чтобы начать им пользоваться, выделите на 

сцене элемент, который Вы хотите обрезать, а затем в панели Properties найдите 

подраздел Clip. Как и при создании падающих теней, в правом верхнем углу этого 

подраздела есть кнопка, которая включает и выключает этот эффект. 

В центре подраздела Clip находятся четыре поля для ввода числовых значений, 

cвязанных с обрезкой верха, низа, правой и левой стороны выделенного элемента. В 

большинстве случаев наиболее легкий способ выполнить такую обрезку – это: 

 навести курсор мыши на нужное поле для ввода значений, 
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 кликнуть и потянуть мышь в сторону, наблюдая при этом, 

сколько отрезается от элемента. 

 

 
 

Если Вы любитель точных чисел, то просто введите нужное число в 

соответствующее поле. 

После обрезки можно перемещать элемент по сцене, при этом скрытые его части 

останутся невидимыми. 

Можно ли анимировать обрезку, спросите Вы. Да! Как и любое другое свойство 

объекта, она анимируется, поэтому используйте эту возможность для создания 

интересных анимационных переходов. 

Обрезать можно практически любой элемент, который Вы помещаете на сцену. 

Следовательно, импортированная графика типа фотографий, текстовые блоки и 

символы тоже попадают в этот список. 

Для ручной модификации используйте инструмент Clipping Tools. Выделите 

объект. Нажмите на инструмент Clipping Tools. Он покажет и полный объект, и 

обрезанную область. Можно перемещать и трансформировать обрезанную часть, 

наведя курсор на внутреннюю рамку. 

Импортирование графики 

 

В Adobe Edge Animate достаточно легко создавать простые геометрические 

формы с помощью инструментов Rectangle Tool (Прямоугольник), Rounded Rectangle 

Tool (Прямоугольник со скругленными углами) и Ellipse Tool (Эллипс). 

Но когда дело доходит до создания более сложных форм, Вы, скорее всего, 

предпочтете более привычные инструменты, например Adobe Illustrator, Corel Draw или 

Inkscape (бесплатный). Для фотографий – Photoshop, Lightroom или GIMP 

(бесплатный). Возможно, Adobe Fireworks будет лучшим решением для совместной 

работы с Edge Animate, т.к. обе программы предназначены для создания веб-контента. 

Нет никакой разницы в том, как Вы создавали файлы форматов JPG, GIF, PNG 

или SVG – Вы можете без проблем импортировать их в Edge Animate и затем 

анимировать, меняя их положение на сцене и визуальные характеристики. 
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Эти файлы будут сохранены в их родном формате (JPG, SVG, PNG или GIF) в папке 

images. 

Помните о том, что если Вы переименуете, удалите или переместите эти файлы, 

то часть анимации будет потеряна! 

После импорта файлы будут считаться растровыми, поэтому экспортируйте их из 

программ-создателей в максимальном размере, с которым они будут использоваться в 

Вашей анимации. Таким образом, Вы избежите пикселизации, которая возникает при 

увеличении картинок. 

С другой стороны, нет нужды делать картинки больше того размера, в котором 

они будут отображаться на экране – это лишь приведет к увеличению времени загрузки 

Вашей анимации. 

Например, если Вы решили создать слайдер размером 600 х 400 px и каждая 

фотография в нем будет заполнять всю сцену, то сохраняйте картинки такого же 

размера. Уменьшение картинки не ухудшает ее качество в отличие от ее увеличения. 

Т.е. Вы можете взять эти картинки и уменьшить их до размера 150 x 100 px, например, 

при создании их миниатюр для предварительного просмотра. Потери качества не 

произойдет. 

При импорте файлов различных форматов сам процесс импорта одинаковый: 

 в главном меню программы Edge Animate заходите в File → Import; 

 в открывшемся диалоговом окне находите папку и файл, который Вы хотите 

импортировать. Если Вам нужно импортировать сразу несколько файлов, то 

выделяйте их все сразу. Edge Animate импортирует их и даст имена идентичные 

именам файлов; 

 после этого все картинки можно увидеть в панели Elements. 

Кроме того, каждая картинка будет автоматически помещена на сцену в нулевую 

позицию 0,0. При одновременном импорте нескольких картинок они, возможно, будут 

перекрывать друг друга на сцене. Помните о том, что они размещаются на разных 

уровнях по глубине. 

Если Вам нравится импортировать картинки простым перетаскиванием, например, 

из Windows Explorer, то Edge Animate предлагает Вам и такую возможность. При этом 

программа показывает текущие координаты изображения (X,Y), чтобы Вы могли легко 

поместить его в нужную позицию на сцене. 

 

 

 

Глава 9. Редактирование объектов 
 

В веб-дизайне трудно добиться контроля над тем, как посетители будут 

просматривать Ваши веб-страницы. Они могут, например, с легкостью изменять 

размеры окна браузера. Вы не знаете точно, будет ли Ваша работа одинаково хорошо 

отображаться на мобильном телефоне и 30-дюймовом мониторе компьютера. 

Пользователь может изменить размер шрифта на странице. Кроме того, сами 

устройства, показывающие веб-сайт, во многом отличаются: 

 настольный компьютер; 

 ноутбук; 

 интернет-планшет; 

 смартфон; 

 мобильный телефон; 

 LCD-дисплей, встроенный в панель управления автомобиля; 

 и т.д. 
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Ситуация, как говорят, непредсказуемая. Поэтому перед дизайнером стоит 

непростая задача — создать приложение, адекватно отвечающее всем этим условиям. 

Причем Вы никогда не сможете учесть все обстоятельства! 

Но есть и хорошая новость: Edge Animate поможет Вам создавать такие веб-

страницы, которые будут автоматически адаптироваться к различным условиям при их 

просмотре. 

 

Дизайн с фиксированным размером 

 

Прежде всего нужно сказать, что в программе можно создавать анимации, у которых 

фиксированный размер. Для этого нужно просто использовать px (пикселы) в качестве 

единиц измерения для сцены и всех элементов, которые на ней находятся. При таких 

условиях размеры сцены и объектов на ней будут неизменными, т.е. фиксированными. 

Тогда, например, если окно браузера меньше чем анимация, то посетители будут 

видеть только ее часть. Чтобы увидеть остаток — используются полосы прокрутки. 

С другой стороны, если посетители просматривают Ваш сайт на огромном 

мониторе, то Ваша анимация будет им казаться слишком маленькой относительно его 

размера. Возможно, они захотят использовать встроенную в браузер операцию 

увеличения, чтобы приблизить изображение. 

В связи с вышесказанным можно посоветовать следующее. Если Вы только 

начинаете изучать Adobe Edge Animate, то Вам лучше использовать фиксированные 

размеры для своих анимаций. Такая ситуация более понятна и предсказуема, пока Вы 

набираетесь мастерства в работе с программой. 

 

Адаптивный дизайн 

 

В этом случае в качестве единиц измерения нужно использовать % (проценты) 

вместо px (пикселов). Вы хотите, к примеру, чтобы сцена была во всю ширину экрана. 

Для этого установите свойство W (ширина) равной 100%. Даже если Ваш посетитель 

будет изменять размер окна браузера, анимация будет адаптироваться к имеющемуся 

пространству. Аналогичная ситуация и с элементами на сцене. Хотите, чтобы они 

масштабировались вместе с окном браузера? Назначайте им % в качестве единиц 

измерения. 

Создавая адаптивный дизайн, Вам нужно будет принимать решение по каждому 

элементу: какой метод использовать для его лучшего отображения в окне браузера. 

Возможно, для текста это будет один способ, а для графики другой. Инструменты для 

создания адаптивного дизайна находятся в подразделе Position and Size 

(Местоположение и размер) панели Properties (Свойства). 

Инструмент Relative Position Point (Точка отсчета относительного положения) 

позволяет выбрать точку, относительно которой программа будет рассчитывать 

свойства элемента X и Y. Кнопка-переключатель Global and Local (Глобальные и 

локальные) дает Вам возможность выбирать, будут ли параметры элемента 

рассчитываться относительно сцены или его родительского контейнера (тег <div>). 
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Чтобы увидеть дополнительные опции, кликните на кнопке в левом 

нижнем углу подраздела Position and Size. Перед Вами появятся свойства Min W 

(минимальная ширина) и Max W (максимальная ширина). Они устанавливают 

ограничения на растягивание и сжатие элементов. 

И, естественно, что выбор процентов для местоположения (X и Y) и размеров 

(W и H) является ключевым моментом при создании адаптивного дизайна. 

Как видите, Edge Animate предлагает большое количество возможностей для 

работы. Чтобы научиться успешно их использовать, да еще и в различных 

комбинациях, необходимы время и практика. В каждом проекте Вы будете сначала 

экспериментировать, а затем уже принимать решение о том, какой будет его рабочая 

версия. 

Чтобы помочь Вам в этом, программа предлагает несколько стандартных 

предустановок. Выделите любой элемент на сцене, а затем в правом верхнем углу 

подраздела Position and Size кликните на кнопке меню Use Presets for Responsive Layout 

(Используйте предустановки для адаптивного дизайна). Перед Вами появятся 

варианты: Scale Position и Scale Size. О том, как их использовать Вы узнаете в 

следующих примерах. 

 

Rotate (Вращение), Skew (Искажение) и Scale (Масштабирование) объектов в Edge 

Animate 
 

Для того чтобы вращать, масштабировать и искажать созданные в Adobe Edge 

Animate объекты, используйте специальный инструмент Transform Tool (Инструмент 

трансформации) и свойства трансформации в подразделе Transform панели Properties. 

Вот названия этих свойств: Rotate (Вращение), Skew (Искажение) и Scale 

(Масштабирование). Еще одно свойство в этом подразделе называется Transform Origin 

(Начало координат трансформации) — это своеобразная опорная точка. Она появляется 

при выделении элемента. Изначально, в момент создания объекта, она расположена в 

его центре. 

 

 
 

При вращении прямоугольника он поворачивается вокруг этой опорной точки. 

Если ее переместить в правый нижний угол, установив X = 100% и Y = 100%, то 

прямоугольник будет вращаться вокруг точки правого нижнего угла. Используя 

свойства транформации опорной точки X и Y, можно перемещать ее в любое место на 

Вашем прямоугольнике. Во время изменения этих свойств сама точка визуально 



 45 

перемещается по поверхности. Чтобы двигать эту точку вручную — используйте 

инструмент Transform Tool. 

Rotate (Вращение) 

 

Управлять свойствами вращения легко. Когда Вы создаете элемент вроде 

прямоугольника, значение свойства Rotate (Вращение) равно 0°. Чтобы вручную 

вращать элемент, используйте инструмент Трансформ Tool. Чтобы вводить конкретные 

числовые значения, делайте это в поле Rotate подраздела Transform. 

Для того чтобы превратить вращение в анимацию, необходимо создать два 

ключевых кадра на шкале времени с различными значениями для свойства Rotate. К 

примеру, если в первом ключевом кадре это свойство равно 0°, а во втором 360°, то 

прямоугольник совершит полный оборот за определенный промежуток времени. 

Установив второе значение на 720°, Вы заставите его повернуться дважды за тоже 

время. 

Skew (Искажение) 

 

Это свойство превращает Ваш прямоугольник в параллелограмм, перемещая две 

его противолежащие стороны в различных направлениях. Поле, расположенное вверху 

Skew X, перемещает верхнюю и нижнюю стороны. Поле, расположенное внизу Skew Y, 

– правую и левую. Для того чтобы лучше понять, как работать с этим инструментом, 

просто поэкспериментируйте с его свойствами. 

 

Scale (Масштабирование) 

 

При масштабировании объекта Вы изменяете его размеры, т.е. делаете его 

больше или меньше. Единицами измерения здесь назначены % (проценты). Аналогично 

свойству Size (Размер) масштабирование может быть пропорциональным либо нет. Для 

этого включайте и выключайте кнопку в виде звена цепочки слева от полей Scale X и 

Scale Y. 

 

 

Выравнивание, распределение и ранжирование элементов в Edge Animate 
 

Поговорка «Всему свое время и место» приходится как нельзя кстати, когда речь 

заходит об анимации. Если на сцене находится более одного элемента, то их 

«взаимоотношения» очень важны. Очень часто дизайнеры, создавая макеты, 

используют специальную сетку. И когда элементы композиции: текст, графика и пр. – 

выровнены по этой невидимой сетке, то это положительно влияет на ее (композиции) 

зрительное восприятие, а работа в целом работа выглядит более аккуратной и 

профессиональной. 

Adobe Edge Animate предлагает Вам в помощь несколько инструментов для облегчения 

выравнивания, распределения и ранжирования элементов на сцене. 

Для того чтобы поэкспериментировать с этими инструментами, создайте 3-4 

простых объекта. Пусть это будут прямоугольники или прямоугольники со 

скругленными углами. 

Во время перетаскивания этих объектов по сцене Вы увидите, что периодически 

появляются и исчезают вертикальные и горизонтальные линии пурпурного цвета, 

которые совпадают с гранями объектов и их центральными точками. Это «умные» 

направляющие. Они помогут Вам быстро выровнять объекты во время их 

перетаскивания вручную. Очень часто даже такого выравнивания будет вполне 

достаточно для общего улучшения композиции. 
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Если Вы решите в какой-то момент, что эти направляющие Вас больше 

отвлекают, чем помогают, то Вы отключите их с помощью горячих клавиш Ctrl + U. 

Кроме того, все процедуры по выравниванию элементов Вы можете делать через 

главное меню программы Modify → Align (Модификация → Выравнивание). Чтобы 

выравнивание заработало, нужно выделить хотя бы два элемента. Кстати, одним из них 

может быть и сцена. Элементы можно выделять прямо на сцене, либо выбирая их в 

панели Elements. Перед тем как использовать эти команды — выделите все элементы, 

которые Вы хотите выровнять и затем выберите одну из следующих опций: 

 

 Modify → Align → Left 

 Modify → Align → Horizontal Center 

 Modify → Align → Right 

 Modify → Align → Top 

 Modify → Align → Vertical Center 

 Modify → Align → Bottom 

 

 
Для того чтобы разместить элементы на равных расстояниях друг от друга по 

горизонтали и вертикали, используйте команду Modify → Distribute (Модификация → 

Распределение). При этом можно выбирать определенную часть элемента как опорную 

для предстоящего распределения. Вот предлагаемые команды в меню: 

 

 Modify → Distribute → Left 

 Modify → Distribute → Horizontal Center 

 Modify → Distribute → Right 

 Modify → Distribute → Top 

 Modify → Distribute → Vertical Center 

 Modify → Distribute → Bottom 
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Линейки и направляющие 

 

Вверху и слева сцены расположены линейки. Они помогают размещать 

элементы на сцене с большой точностью. При необходимости эти линейки можно 

спрятать, используя меню View → Rulers (Вид → Линейки) или горячие клавиши Ctrl + 

R. Линейки тянутся за пределы сцены, но на них есть маркеры, которые отмечают ее 

границы. 

 

 
Для облегчения работы по выравниванию элементов можно создавать 

вспомогательные направляющие. Для этого кликните на любой из линеек и потяните 

мышь по направлению к центру сцены. Отпустите левую кнопку мыши, и 

вспомогательная линия останется на этом месте. Если Вы захотите переместить ее в 

другое место, то просто перетащите ее туда. 

Если вспомогательная линия Вам больше не нужна, то ее можно удалить, 

перетащив снова на линейку. Чтобы случайно не нарушить точно настроенную систему 

из вспомогательных линий — воспользуйтесь командой View → Lock Guides (Вид → 

Зафиксировать направляющие). Это сделает невозможным их перемещение до тех пор, 

пока Вы не снимите этот запрет командой View → Unlock Guides (Вид → Освободить 

направляющие). 
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Для облегчения работы по выравниванию используйте команду Snap 

to Guides (Прилипать к направляющим). 

Понятно, что допускается создавать такое количество направляющих, какое Вам 

необходимо. Если их окажется слишком много, и они начнут мешать общему 

восприятию композиции — отключайте-включайте их командой View → Guides (Вид 

→ Направляющие) или с помощью горячих клавиш Ctrl + ; 

 

 
 

Ранжирование элементов 

 

В дополнение к горизонтальному и вертикальному позиционированию 

элементов существует еще одна возможность размещать их друг относительно друга. 

Вы уже, наверное, заметили, что при создании элементов новые появляются поверх 

уже созданных. И если Вы поместите новый элемент в положение с теми же 

координатами X и Y, что и старый, то он перекроет его. 

Если Вы знакомы с такой программой, как Photoshop, то Вам наверняка пришла 

в голову идея слоев. Фактически мы имеем дело с распределением объектов по оси Z. 

Чтобы лучше понять существующий порядок элементов на сцене, достаточно взглянуть 

на панель Elements. Те элементы, которые находятся в верхней части списка — ближе к 

Вам. Если Вы захотите изменить этот порядок — просто перетяните элемент на 

нужную позицию в панели. 

Кроме того, Edge Animate предлагает несколько полезных команд и горячих клавиш 

для изменения порядка элементов: 

 

 Modify → Arrange → Bring to Front (Ctrl + Shift + ]) 

 Modify → Arrange → Bring Forward (Ctrl + ]) 

 Modify → Arrange → Send Backward (Ctrl + [) 

 Modify → Arrange → Send to Back (Ctrl + Shift + [) 
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Глава 10. Анимация элементов 
 

В этом примере нам нужно будет создать 4 прямоугольника. Мы дадим им 

имена, присвоим цвета и придадим им небольшой наклон (исказим). После этого мы 

определим их позиции на сцене и заставим двигаться, изменять форму и в конце 

исчезнуть. Такой визуальный эффект можно использовать в баннерах или во 

вступительной части к более сложной анимации. 

Итак, это упражнение делится на две части. В первой мы создадим цветные 

полоски и затем разместим их на сцене. В итоге мы должны будем создать анимацию, 

как показано в Уроке Предпросмотр анимации и проверка на ошибки. 

Создайте и сохраните новый проект в Adobe Edge Animate. Присвойте ему 

любое имя, ну, например, color_bars. Не забудьте создать новую папку для Вашего 

проекта. 

Цвет сцены измените на белый, а ее размеры определите как W = 550 px и H = 400 px. 

Программа запоминает последние установки, которые Вы использовали, поэтому если 

Вы выполняли упражнения из предыдущих уроков или сами экспериментировали в 

программе, то Вам нужно сделать такие изменения. 

Убедитесь, что на шкале времени кнопки Auto Keyframe Mode и Auto Transition 

Mode нажаты. 

Во время движения курсора над кнопками или инструментами появляются их 

имена. Например, в верхней части шкалы времени можно увидеть Auto-Keyframe Mode, 

Auto-Transition Mode, Toggle Pin и Easing. 

Нарисуйте прямоугольник и в поле ID в панели Properties введите его имя Red. 

Это поле находится в верхней части панели Properties, но, чтобы оно появилось, не 

забудьте выделить прямоугольник. 

В панели Properties кликните на образце цвета фона и выберите чистый красный 

цвет, а толщину контура задайте как none. После этих действий цвет прямоугольника 

Red должен быть #ff0000. 

Определите размер прямоугольника. Пусть он будет следующим W = 550px и H 

= 100 px. Самый быстрый способ это сделать — ввести значения ширины W и высоты 

H в соответствующих полях панели Properties, но если Вы хорошо управляетесь с 
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мышью, то тогда тяните за маленькие белые квадраты по периметру объекта. 

Возможно, Вам нужно будет кликнуть на маленькой кнопке в виде звена цепочки 

рядом с W и H, чтобы отдельно редактировать ширину и высоту фигуры. 

Присвойте свойству SkewX значение 50°. Поле ввода значений горизонтального 

наклона расположено вверху. Положительные значения перемещают верхнюю грань 

влево, а нижнюю вправо. 

Разместите Ваш красный скошенный прямоугольник в левом верхнем углу 

сцены таким образом, чтобы был виден только его кончик. Его местоположение 

должно быть таким X = -550 px, Y = 0 px. В идеале в левом верхнем углу сцены должен 

быть виден только красный треугольник. 

Выделите красный прямоугольник и нажмите горячий клавиши Ctrl + D. 

Измените ID копии красного прямоугольника на Green и задайте ему соответствующий 

цвет #00ff00. Изменение цветов объектов, созданных в Edge Animate, можно делать как 

в панели Properties, так и в панели инструментов над сценой. 

Команда дублирования элементов Ctrl + D аналогична двухшаговому процессу, 

состоящему из команд копирования Ctrl + C и вставки Ctrl + V. В любом случае Вы 

создадите новую копию элемента со словом "Copy" в конце его имени. 

Выровняйте зеленый прямоугольник по нижнему краю красного (Y = 100 px ). 

Затем, при нажатой клавише Shift, сдвиньте зеленый прямоугольник вправо таким 

образом, чтобы на сцене был виден его кончик ( X = 430 px ). 

Нажатая клавиша Shift помогает удерживать объект при перемещении строго 

горизонтально (ось X) или вертикально (ось Y). Вы можете, конечно, нарушать эту 

связь с осями, но объект «прилипает» когда нужно, и это помогает с ним управляться. 

Создайте еще два скошенных прямоугольника. Дайте им имена Blue и Yellow. 

Расположите их на противоположных сторонах сцены. Голубой цвет: #0000ff, а 

желтый: #ffff00. В итоге общая композиция на сцене должна выглядеть как на 

скриншоте ниже. 

Если позднее у Вас будут проблемы с анимацией этих элементов, то нарисуйте с нуля 

последние два прямоугольника вместо того, чтобы создавать их с помощью 

дублирования. Дело в том, что некоторые ранние версии Edge Animate могут работать с 

ошибками при дублировании элементов более одного раза. Наверняка этот недостаток 

будет устранен в последующих версиях программы. 

 

Анимация с помощью ключевых кадров 

 

Итак, в начале нашей анимации мы создадим ключевые кадры для свойств 

Position (Местоположение), Size (Размер) и Opacity (Прозрачность). Затем, 

переместившись по шкале времени, мы создадим другие ключевые кадры для этих же 

свойств. В результате мы получим анимацию. Приступим. 

Убедитесь, что головка плейера находится в значении 0:00. Выделите красный 

параллелограмм Red и затем в панели Properties кликните на кнопках-ромбиках рядом 

со свойствами X, Y, W, H и Opacity. 

Свойства X и Y находятся в подразделе Position and Size и контролируют 

местоположение элемента на сцене. Кнопки для W и H создают ключевые кадры для 

ширины и высоты. Слайдер Opacity расположен вверху панели Properties. На 

скриншоте ниже показаны кнопки-ромбики, ключевые кадры, а также эти свойства, 

расположенные на отдельных слоях шкалы времени. Ключевые кадры свойств 

записывают значения свойств (величину) в определенный момент времени. В итоге на 

шкале времени Вы должны увидеть ключевые кадры и слои свойств для: 

 Width 

 Height 

 Opacity 
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 Left 

 Top 

 

 
 

Если Вы не видите все эти ключевые кадры и шкалу времени для каждого из 

свойств элемента Red, то создайте их вручную, кликая мышкой на кнопке-ромбике Add 

Keyframe for рядом со свойством в панели Properties. 

Для того чтобы показывать-прятать слои свойств элемента на шкале времени, 

кликните на маленькой кнопке-треугольнике рядом с именем элемента. Кнопка над 

всеми слоями шкалы времени слева от слова Actions скрывает-показывает слои свойств 

всех элементов сразу. 

Повторите все предыдущие действия для слоев Green, Blue и Yellow. Для того 

чтобы ускорить процесс создания ключевых кадров и слоев свойств, выделите все три 

элемента и затем кликайте на кнопках-ромбиках Add Keyframe for. 

Убедитесь, что на шкале времени кнопки Auto-Keyframe Mode и Auto-Transition Mode 

нажаты, а другие нет. 

Если кнопка Auto-Keyframe Mode нажата, то Edge Animate автоматически создает 

ключевые кадры для свойств элементов. Этот процесс состоит из двух шагов: 

 переместите головку плейера на шкале времени; 

 затем измените свойства элемента. 

Эти изменения можно делать как в панели Properties, так и непосредственно на 

сцене с помощью инструментов Selection (Выделение) Transform (Трансформация). 

Переместите головку плейера в значение 0:02 на шкале времени. На этом шаге кнопка 

Toggle Pin не должна быть нажата. 

Переместите все полоски на сцене, как показано на рисунке ниже. 
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Теперь большая часть сцены покрыта цветными полосками, и лишь белые 

треугольники сцены показываются на ее границах. Во время перетаскивания полосок 

не забудьте удерживать клавишу Shift для перемещения их строго по горизонтали. 

Выделите все полоски и кликните на кнопке Add Key Keyframe (Добавить 

ключевой кадр) свойства Opacity (Прозрачность). Подвигайте головку плейера вперед-

назад, чтобы увидеть анимацию. На шкале времени в точке 0:02 прозрачность для всех 

полосок установлена на 100%. 

Перетащите головку плейера на 0:03. 

Выделите все полоски и измените их высоту H до 300 px, а прозрачность до 

50%. Это создает эффект увеличения полосок, и в тоже время они становятся 

прозрачными. Помните о том, что Вам, возможно, нужно будет нажать кнопку Link 

Width and Height (Связать ширину и высоту), чтобы изменять свойства W и H 

независимо друг от друга. 

 

 
Переместите головку на 0:04. Затем измените высоту каждой полоски до 500 px, 

а прозрачность до 0%. В результате полоски продолжают увеличиваться и исчезают. 
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Предпросмотр анимации и проверка на ошибки 
 

После того как Вы закончили, Ваша анимация должна выглядеть примерно вот 

так: 

 
  

Для того чтобы просмотреть созданную анимацию, нажмите клавишу Home в 

программе Adobe Edge Animate, затем клавишу Пробел или используйте небольшую 

панель управления в панели Шкала времени. 

Если анимация воспроизводится немного не так, как Вы предполагали, то, 

скорее всего, причина в том, что значения некоторых свойств ключевых кадров были 

заданы неправильно или отсутствуют. 

Переместите головку плейера в значение 0:00 на шкале времени и проверьте, чтобы 

у всех цветных полосок были правильные значения свойств для: 

 

 Width 

 Height 

 Opacity 

 Left 

 Top 

 

Наиболее часто встречающаяся ошибка: свойству вообще не присвоено значение 

или присвоено с ошибкой. 
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Если воспроизведение Вашей анимации снова происходит некорректно, 

то проверьте значения свойств в позициях головки плейера 0:02, 0:03, 0:04 на шкале 

времени. 

Если Вы хотите немного поэкспериментировать, то попытайтесь другими 

способами изменить цвет, размер или наклон полосок во времени. Добавьте фоновую 

картинку или текст, чтобы в итоге сделать анимацию более интересной зрительно. 

 

Глава 11. Создание слайд-шоу 

 
Показ и скрытие элементов 

Иногда на сцене находится большое количество объектов, и в результате трудно 

найти нужный. В такой ситуации на помощь приходит панель Elements, которая может 

показывать и скрывать элементы. 

Слева от имени элемента расположена иконка «глаз», являющаяся кнопкой, 

которая работает в режиме переключателя — нажатие на нее либо показывает, либо 

скрывает элемент. Когда эта иконка видна, то и элемент виден на сцене. Кликните на 

ней, и она превратится в круг, а элемент исчезнет. Кнопка «глаз» воздействует на 

видимость элементов только в пределах рабочего пространства Edge Animate. При 

просмотре готовой анимации в браузере она не оказывает эффекта. 

 

 
 

Вам необходимо знать, что существует разница между тем, как Edge Animate 

работает с графикой, созданной непосредственно в программе, например, с помощью 

инструмента Rectangle Tool (Прямоугольник), и той, которая импортирована. 

Графика, созданная в программе, создается «на лету» с помощью кода JavaScript, тогда 

как импортированная графика сохраняется в виде файла. 

При импорте графики Edge Animate автоматически помещает ее верхний левый 

угол в верхний левый угол сцены (координаты 0,0). 

Когда Вы, например, делаете слайдер, то проблем нет, если размер 

импортируемой картинки совпадает с размером сцены, скажем, обе равны 600 х 400 px. 

Если же размеры сцены меньше (по умолчанию она равна 550 х 400 px), то картинка 

будет немного больше чем нужно. Чтобы исправить это несоответствие, просто 

увеличьте размер сцены до 600 х 400 px. 
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В предыдущем примере мы рассмотрели способ показа и скрытия 

элементов с помощью свойства Opacity. Если установить его значение равным 0, то 

элемент исчезнет. Это свойство особенно хорошо использовать для достижения 

нужных визуальных эффектов, например, в слайд-шоу и т.д. 

Итак, используя свойство Opacity, мы можем легко заставить элементы 

появляться и исчезать, но при этом нужно не забывать контролировать это свойство во 

временных рамках всей композиции. 

Существует еще один фундаментальный способ показа и скрытия элементов на 

сцене. 

Их можно включать On и выключать Off (и это уже влияет на их отображение в 

браузере при просмотре финальной композиции). 

В панели Properties, прямо под полем для ввода ID (идентификатор) элемента, 

находится небольшое выпадающее меню, изначально установленное на Always On 

(Всегда включено). 

 

 
 

В наших предыдущих примерах мы использовали именно эту опцию для контроля 

видимости элементов. Но существуют еще две других: 

 On 

 Off 

Предположим, что Вы хотите, чтобы в Вашем слайд-шоу картинки сменяли друг 

друга мгновенно, а не плавно, т.е. без всякого движения и эффектов. 

Это как раз тот случай, когда указанный переключать подойдет лучше всего. 

Давайте создадим простое слайд-шоу, в котором используем возможности включения и 

выключения элементов. 

1.Создайте новый проект и импортируйте в него несколько картинок. В идеале 

картинки и сцена должны быть одного размера. 

2.После того как Вы их разместите на сцене строго одна под другой, установите для 

верхней переключатель в положение On, а для всех остальных в Off. 
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3.Перетащите головку плейера на 0:02 (или в любую другую отметку на шкале 

времени). 

4.Выключите ту картинку, которая сейчас видима (выберите опцию Off 

переключателя), а следующую включите (On). В такой ситуации положение 

картинок в стопке (стеке) не имеет значения, поскольку только одна из них 

включена, т.е. видима.  

 

 
 

5.Необходимо помнить, что поскольку Вы используете меню скрытия/показа 

элементов в панели Properties, то Edge Animate добавляет переключатель On/Off 

в виде кнопки для этого элемента на шкале времени. Это позволяет быстро 

показывать и скрывать элементы: 

•установите головку плейера на нужную точку; 

•включите или выключите переключатель On/Off. 
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6.Проделайте аналогичные действия с оставшимися картинками. 

Итак, буквально за несколько минут мы создали слайд-шоу, которое может 

украсить любой веб-сайт.  
 

Подобные слайд-шоу широко используются на веб-сайтах для представления 

товаров и услуг. Например, если Вы продаете автомобили, то наверняка захотите 

показать все доступные цвета модели и т.д. 

В этом примере мы создадим такое автоматизированное слайд-шоу. Каждая 

картинка будет показываться в течение определенного промежутка времени, а затем 

исчезнет со сцены. 

Итак, для этого упражнения Вам понадобятся 3 картинки. Создайте их или 

возьмите уже готовые. Например, это могут быть фотографии, снятые Вами или 

позаимствованные из бесплатных источников в интернете. Ваше слайд-шоу будет 

выглядеть лучше всего, если эти картинки будут одного размера и одинаковой 

ориентации: вертикальные или горизонтальные. 

 

Приступим: 

 

1.Импортируйте файлы картинок в новый проект, созданный в Adobe Edge Animate. 

Используйте главное меню программы File → Import. 

Edge Animate автоматически помещает картинки на сцену и создает папку 

images, в которой будет хранить копии этих файлов. В панели Library 

(Библиотека) Вы должны увидеть три картинки в подразделе Assets. 

2.В панели Elements выделите сцену (stage), а затем установите ее размеры и цвет 

фона. Параметр Overflow сделайте hidden. Размеры сцены сделайте равными 

фотографиям (600 х 400 px). Так как Overflow у нас hidden, то картинки будут 

исчезать, уходя со сцены. 

3.Измените порядок картинок таким образом, чтобы та картинка, которая по Вашей 

задумке должна быть первой в слайд-шоу оказалась сверху других в панели 

Elements. Для этого выделите ее и перетащите на первую позицию. В этом 

проекте положение картинки в стеке (стопке) определяет то, когда она будет 

показана. Это похоже на то, как мы обычно просматриваем фотографии: убирая 

верхнюю, смотрим на следующую, которая внизу. 

4.Нажмите клавишу Shift и выделите все картинки в панели Elements. Затем в 

панели Properties кликните на кнопке Add Keyframe рядом с X и Y. Для каждой 

картинки будут созданы ключевые кадры на шкале времени в 0:00. Это их 

стартовая позиция. 

5.Проверьте, чтобы все картинки были выделены, а свойство Opacity 

(Непрозрачность) в панели Properties равнялось 100%. После этого кликните на 

кнопке Add Keyframe for Opacity (маленький ромбик), чтобы добавить ключевой 

кадр для непрозрачности. В результате у всех картинок непрозрачность будет 

равна 100% до того момента, пока они не начнут покидать сцену. 

6.Перетащите головку плейера в значение 0:02. Кликните мышью где-нибудь вне 

сцены, чтобы снять выделение с картинок. Теперь выделите только первую 

картинку и снова добавьте ключевые кадры для X,Y и Opacity. Это определит ее 

положение и непрозрачность для первых 2-х секунд слайд-шоу. Далее 

фотографии начнут двигаться и изменять свой облик. Убедитесь, что шпилька 

(pin) и головка плейера перемещаются в новое положение вместе. Если нужно, 

то нажмите клавишу P, чтобы включить шпильку. 

7.Убедитесь, что Auto-Keyframe Mode (Режим автоматического создания ключевых 

кадров) и Auto-Transition Mode (Режим автоматического создания переходов) 

включены. 
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Если кнопка Auto-Keyframe Mode нажата, то Edge Animate будет 

автоматически создавать ключевые кадры для свойств X и Y, когда Вы 

перемещаете фотографию. Если эта кнопка не нажата, то Вы можете создавать 

ключевые кадры вручную, кликая на кнопке Add Keyframe рядом со свойствами 

X и Y в панели Properties. 

8.Перетащите головку плейера на 0:03, а затем переместите верхний слайд таким 

образом, чтобы он покинул сцену. Вы можете перемещать картинки в любом 

направлении. Движение картинок вправо напоминает то, как это было в старых 

диапроекторах. Нажатие клавиши Shift поможет Вам перемещать картинку 

строго по вертикальной или горизонтальной осям. 

9.После того как картинка окажется вне сцены, измените непрозрачность до 20%. 

Это создаст интересный эффект исчезновения для каждой картинки во время 

ухода их со сцены. 

10.Переместите головку плейера еще на 2 секунды вправо. Именно этот 

промежуток времени зритель будет созерцать следующую по счету фотографию. 

11.Выделите верхнюю картинку в стеке и в панели Properties кликните на кнопке 

Add Keyframe для X, Y и Opacity. Таким образом Вы создадите ключевые кадры 

для положения картинки на сцене по осям X и Y, а также непрозрачности. По 

аналогии с предыдущим слайдом она будет двигаться и исчезать сразу после 

этой точки (0:05) на шкале времени. 

12.Перетащите головку плейера еще на 1 секунду вдоль шкалы времени (0:06), а 

выделенную фотографию переместите вправо, чтобы она покинула сцену, и 

установите для нее непрозрачность равной 20%. На этом работа со второй 

картинкой будет закончена. 

13.Для каждой из оставшихся картинок Вашего слайд-шоу повторите действия 

предыдущих двух шагов. 

14.После того как последний слайд исчезнет со сцены, покажите зрителям какое-

нибудь сообщение. Например, Спасибо за внимание! Оно тоже может мягко 

появляться на сцене, а затем исчезать, фиксируя момент окончания слайд-шоу. 

Теперь Вы можете сделать предварительный просмотр Вашего слайд-шоу 

непосредственно в программе Edge Animate или в Вашем рабочем браузере. К 

этому моменту, возможно, у Вас уже появились какие-то идеи относительно 

того, как Вы можете улучшить или изменить это слайд-шоу. 

Например, можно увеличить время просмотра каждой фотографии и ее ухода со 

сцены. Если Вы хотите создать имитацию эффекта в стиле 3D, то используйте 

свойства Skew и Size. В последующих уроках Вы научитесь создавать 

управляющие кнопки, с помощью которых Ваши зрители смогут сами 

контролировать появление картинок в слайд-шоу. 

 

Глава 12. О форматах файлов и Edge Animate 
 

В мире двумерной (2D) компьютерной графики существует две системы хранения и 

отображения изображений: 

 

 растровая графика (bitmap); 

 векторная графика. 
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Растровая графика представляет собой набор пикселей, каждый из которых 

характеризуется своим положением и цветом. Когда мы говорим bitmap, то имеем в 

виду не формат файла с расширением .bmp, а, фактически, любую картинку, 

сохраненную в одном из растровых форматов, а именно .gif, .jpg, .tiff и .png. 

Самое главное достоинство растровых форматов следующее: они позволяют 

создавать реалистичные изображения со сложными цветами, градиентами и едва 

заметными оттенками. Недостатки тоже есть: 

 в несжатом виде размер растровых картинок может быть большим и, 

следовательно, занимать приличный кусок дискового пространства; 

 плохая масштабируемость (при физическом увеличении качество картинки 

сильно страдает). 

Например, у Вас есть изображение автомобиля. Нужно увеличить ее на 400%. Для 

того чтобы это сделать, программа создает новые пиксели, дублируя уже 

существующие в изображении. Результат, мягко говоря, не всегда удовлетворителен. 

Скорее всего, итоговая картинка будет выглядеть размытой, а скругления 

пикселизированными. 

 

 
 

Векторная графика хранится в компьютерах в виде формул. По сравнению с 

растровой векторная графика, как правило, занимает гораздо меньше места на диске и 

масштабируется без потери качества. Другими словами, если Вы нарисовали 

небольшой автомобиль, а затем увеличили его на 400%, то он будет выглядеть отлично, 

сохранив качество в деталях. 

Перечисленные выше плюсы и минусы двух систем хранения изображений 

важно знать. Растровые лучше использовать там, где требуется фотореализм с большим 

количеством цветов и оттенков. Вектор больше подойдет для линеарных рисунков, 

схем, диаграмм и для картинок, которые Вы планируете в дальнейшем 

масштабировать. 
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Adobe Edge Animate может импортировать 4 типа графических файлов: JPG, GIF, 

PNG и SVG. Однако здесь есть несколько подводных камней, которые, возможно, Вас 

удивят. 

 

JPG 

Файлы этого формата, известные так же, как JPEG, являются растровыми и 

широко используются в сети Интернет и многими цифровыми фотоаппаратами. В JPG 

реализован метод сжатия с потерями, чтобы создать файл меньшего размера. 

Графические редакторы, работающие с JPG, обычно дают возможность выбирать 

степень сжатия (компрессии). Если заранее известно, что картинку будут смотреть 

только на экране, то компрессию можно усилить. Если в дальнейшем предполагается 

печать на принтере, то для лучшего качества на выходе нужно сохранить все пиксели 

(сохранение без сжатия). 

 

GIF 

В последнее время популярность этого растрового формата упала по сравнению 

с JPG и PNG, тем не менее Вы обнаружите его еще на многих сайтах. В нем реализован 

метод сжатия без потерь (lossless), но при этом используется ограниченная по 

количеству цветов палитра. В результате получается картинка с ограниченным 

количеством цветов, но маленького размера. Чаще всего используется для отображения 

логотипов и простой графики. С другой стороны, фотографии с большим количеством 

цветов и оттенков будут выглядеть гораздо хуже в GIF, чем в JPG из-за существующего 

в нем ограничения на количество используемых цветов. 

GIF интересен еще и тем, что в нем можно хранить покадровую анимацию! 

Программы вроде Adobe Fireworks и Flash создают такую анимацию достаточно легко. 

Кроме того, GIF способен хранить части изображения прозрачными. Это особенно 

удобно, если у изображения сложная форма, например, анимированный персонаж, а 

разместить его надо на фоне вроде интерьера помещения. 

 

PNG 

Этот формат был разработан во времена, когда существовал патент на 

использование GIF. Используется он исключительно в сети Интернет и в некотором 

смысле является улучшенной версией GIF. Метод, который используется в нем для 

сжатия данных — без потерь (lossless), цветовая палитра дает возможность 

использовать большее количество цветов чем в GIF, кроме того, он может содержать 

покадровую анимацию и прозрачные части изображения. Этот формат хорошо 

поддерживается современными веб-браузерами, хотя некоторые из старых (но таких 

очень мало) с ним не работают.  

 

 

SVG 

В основу этого формата положен вектор. SVG (Scalable Vector Graphics) — 

масштабируемая векторная графика. Это означает, что вместо того чтобы сохранять 

карту, состоящую из пикселей, SVG содержит формулы, описывающие прямые линии, 

кривые, формы и другие детали изображения. Все современные веб-браузеры 

поддерживают этот формат, но старые с ним работают не стабильно. 

При импорте SVG в Edge Animate, последний конвертирует его в bitmap. Это 

значит, что Вы теряете возможность в дальнейшем масштабировать картинку без 

потери качества, особенно при ее увеличении. Возможно, в следующих версиях 

программы эта проблема будет решена, но на данный момент при импорте векторное 

изображение формата SVG превращается в обычное растровое. 
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Работа со звуком в Adobe Edge Animate 

Давайте создадим новый файл, сделаем его размером 800х600 и перенесем в него 

некоторые файлы, а именно вот эти несколько картинок и «шум леса мп3», то есть звук. 

Я переношу его сюда. Что мы имеем в итоге — вот такую картинку — это лес, она 

называется «bg», «play» и «пауза», это кнопочки. Я перенесу их сейчас вниз, подвинем 

их примерно вот так — самый простой вариант. 

 

Я сейчас запущу анимацию, нажимаю cntr+enter, здесь просто лес и просто две кнопки, 

ничего не работает. Если я хочу сделать, чтобы у меня автоматом играл звук, он 

называется «шум леса», то мне нужно выбрать этот слой и тут выбрать «auto play», 

теперь при нажатии cntr+enter у меня будет воспроизводиться звук. Замечательно. 

Если мне не хочется, чтобы было автоматическое воспроизведение, я убираю эту 

галочку. «Луп» значит зациклить этот звук. Если это шум леса, сделать плавный 

переход, то достаточно небольшого звукового семпла, чтобы постоянно играл этот 

звук. 

Теперь сделаем так, чтобы работали кнопки. Для этого я убираю play, нажимаю правой 

кнопкой open action, клик и в клике выбираю «play аудио», и вот здесь в кавычках я 

пишу его имя, а он называется «шум леса». Закрываю. И на паузе я выбираю open 

action, клик и здесь «пауза аудио» и тоже пишу «шум леса». Теперь закрываем, 

cntr+enter — смотрим что получается… Ничего не получается, звука нет, но если 

нажать на плей, то играет звук леса, если нажать на паузу, то музыка останавливается. 

Все работает замечательно. 

http://fimushkin.ru/wp-content/uploads/2014/06/%D0%B7%D0%B2%D1%83%D0%BA.jpg
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Я бы еще выделил обе кнопки и добавил курсор палец, чтобы было понятно, можно 

добавить вопрос. Посмотрим, как это будет выглядеть при наведении, чтобы было 

понятно, что здесь что-то произойдет. 

Вот таким несложным образом добавляется анимация и происходит работа со звуком в 

программе Adobe Edge Animate. 

Работа с видео 

Выполните одно из следующих действий:  

 Нажмите Файл> Импорт или перетащите мышкой видеофайл непосредственно в 

рабочую область из проводника. Группа с именем видеофайла отобразится в 

библиотеке. Эта группа содержит сам видеофайл и дополнительные файлы, 

других форматов, добавляемые для кроссбраузерности.  

Примечание: файлы других форматов будут автоматически группироваться под 

видео группы по имени, когда Вы импортируете их в композицию.  

http://fimushkin.ru/wp-content/uploads/2014/06/%D0%B7%D0%B2%D1%83%D0%BA1.jpg
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 Нажмите кнопку Добавить видео в библиотеке проекта. Затем 

перетащите группу видео из библиотеки в рабочую область.  

 
Добавить вариант видео в библиотеку 

Функции для управления воспроизведением видео отображаются на панели свойств 

при выборе видеоэлемента на панели элементов.  

Воспроизведение и управление видео 

Вы можете воспроизводить и управлять видео с помощью любого из следующих 

вариантов:  

 Панель свойств  
o Автозапуск: Видеофайл будет проигрываться автоматически.  

o Loop: Делает петлю видеофайла.  

o Controls: Добавляет кнопки управления. 

 
Видеоуправления в панели свойств 

 Шкала времени  
o Воспроизведение: воспроизведение видео файла с текущей позиции 

Playhead.  

o Play From: Позволяет указать маркер времени, с которого Вы хотите 

воспроизвести видео.  

o Пауза: Позволяет остановить воспроизведение видео.  

 
Возможности воспроизведения видео в Timeline 
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 Видеоскрипты: Используя фрагменты кода в редакторе action 

для управления воспроизведением видео с помощью событий.  

Видеоскрипты 

1. Откройте редактор действия, нажав {} на временной шкале.  

2. Выберите событие.  

3. Выберите список действий, выберите видео, а затем выберите нужное действие.  

 

Предзагрузка видео 

Для предварительной загрузки видеофайлов, выберите "Preload видео" в разделе 

предзагрузка на панели свойств сцены.  

Примечание: предварительная загрузка видео не доступна на большинстве мобильных 

устройств.  
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Элементы воспроизведения 

Вы можете использовать по умолчанию медиаплеер браузера, чтобы показать элементы 

управления для видео. Чтобы включить плеер по умолчанию, выберите элемент видео и 

выберите «Управление» в разделе Видео на панели свойств.  

 

Включение видеопроигрывателя. 
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В подготовке пособия использовались следующие источники: 

 

Joseph Labrecque - Adobe Edge Quickstart Guide 

Chris Grover - Adobe Edge Animate Preview 7: The Missing Manual 
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